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Dear Reader,

Thank you for choosing AutoCAD 2011 and AutoCAD LT 2011: No Experience Required. This book is part of a family of premium-quality Sybex books, all of which are written by outstanding authors who combine practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to producing consistently exceptional books. With each of our titles, we’re working hard to set a new standard for the industry. From the paper we print on, to the authors we work with, our goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments and get your feedback on how we’re doing. Feel free to let me know what you think about this or any other Sybex book by sending me an email at nedde@wiley.com. If you think you’ve found a technical error in this book, please visit http://sybex.custhelp.com. Customer feedback is critical to our efforts at Sybex. 

 Best regards,
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 Neil Edde

 Vice President and Publisher

 Sybex, an Imprint of Wiley
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Introduction

This book was born of the need for a simple, yet engaging tutorial that would help beginners step into the world of AutoCAD or AutoCAD LT without feeling intimidated. That tutorial has evolved over the years into a full introduction to the ways in which architects and civil and structural engineers use AutoCAD to increase their efficiency and ability to produce state-of-the-art computerized production drawings and designs.

Because AutoCAD and AutoCAD LT are so similar, it makes sense to cover the basics of both programs in one book. For most of the book, the word AutoCAD stands for both AutoCAD and AutoCAD LT.

[image: ACADonly.eps]
When you come to a section of a chapter that applies to AutoCAD only, the icon shown here is displayed in the margin to alert you. When appropriate, extra information for AutoCAD LT users is provided to give you a workaround or otherwise keep you in step with the tutorial.

Because AutoCAD LT doesn’t have 3D commands or features, the last two chapters, which are an introduction to drawing in 3D, apply only to AutoCAD. But LT users can be assured that LT is very much the same program as AutoCAD, with only minor differences. You’ll be prompted when those differences, most of which are 3D features, come along.

This book is directed toward AutoCAD and AutoCAD LT novices—users who know how to use a computer and perform basic file-managing tasks, such as creating new folders and saving and moving files, but who know nothing or little about AutoCAD or LT (as I’ll call AutoCAD LT throughout the book). If you’re new to the construction and design professions, this book will be an excellent companion as you learn AutoCAD. If you’re already practicing in those fields, you’ll immediately be able to apply the skills you’ll pick up from this book to real-world projects. The exercises have been successfully used to train architects, engineers, and contractors, as well as college and high school students, in the basics of AutoCAD.

For those of you in other trades and professions, the project that runs through the book—drawing a small cabin—has been kept simple so that it doesn’t require special training in architecture or construction. Also, most chapters have additional information and exercises specifically designed for non-AEC (Architecture, Engineering, and Construction) users. Anyone wanting to learn AutoCAD will find this book helpful.

What Will You Learn from This Book??

Learning AutoCAD, like learning any complex computer program, requires a significant commitment of time and attention and, to some extent, a tolerance for repetition. You must understand new concepts to operate the program and to appreciate its potential as a drafting and design tool. However, to become proficient at AutoCAD, you must also use the commands enough times to gain an intuitive sense of how they work and how parts of a drawing are constructed.

At the end of most chapters, you’ll find one or more additional exercises and a checklist of the tools you have learned (or should have learned). The steps in the tutorial have a degree of repetition built into them that allows you to work through new commands several times and build up confidence before you move on to the next chapter.

Progressing through the book, the chapters fall into five general areas of study:


	Chapters 1 through 3 familiarize you with the organization of the AutoCAD user interface, cover a few of the basic commands, and equip you with the tools necessary to set up a new drawing, including the use of a standard such as the National CAD Standard (NCS) to organize your files.

	Chapters 4 and 5 introduce the basic drawing commands and develop drawing strategies that will help you use commands efficiently.

	Chapters 6 through 11 work with AutoCAD’s major features such as blocks, hatches, and annotation. You’ll also learn about using layers to organize the various components of a drawing by applying the National CAD Standard.

	Chapters 12 through 15 examine intermediate and advanced AutoCAD features, including managing and creating document sets using Sheet Set Manager.

	Chapters 16 and 17 cover the 3D modeling tools by exploring 3D solids and 3D surfaces. You’ll also learn how to apply materials to 3D objects allowing you to produce eye-catching 3D visualizations. In the process of exploring these elements, you’ll follow the steps involved in laying out the floor plan of a small cabin. You’ll then learn how to generate elevations from the floor plan, and eventually you’ll learn how to set up a title block and layouts to print your drawing. Along the way, you’ll also learn how to do the following:

	Use the basic drawing and modify commands in a strategic manner

	Set up layers using an established standard

	Assign colors to your drawing

	Define and insert blocks

	Generate elevation views

	Place hatch patterns and fills on building components

	Use text in your drawing







Chapters in the latter part of the book touch on more advanced features of AutoCAD, including:


	Creating dynamic drawings using geometric and dimensional parametric constraints

	Dimensioning the floor plan

	Drawing a site plan and managing drawings of varying units

	Efficiently organizing drawing sets using external references

	Setting up and managing drawings for printing with layouts

	Making a print of your drawing

	Working in 3D (for AutoCAD users)



All these features are taught using the cabin as a continuing project. As a result, you’ll build a set of drawings that document your progress throughout the project. You can use these drawings later as reference material if you need to refresh your memory with material covering a specific skill.

At the end of the book is a glossary of terms that are used in the book and are related to AutoCAD and building design. This is followed by an index.

Files on the Website

If you’re already somewhat familiar with AutoCAD and you’re reading only some of the chapters, or if you want to check your work on the cabin against the book at different stages, you can pull accompanying files from this book’s page on Wiley’s website at www.sybex.com/go/autocad2011ner. Click the Resources & Downloads button on that page.

To further help you learn AutoCAD, a companion website is also available at www.autocadner.com that, in addition to the dataset, also offers a comprehensive library of instructional videos, additional exercises, and more. Visiting this site will also let you view this book’s errata and interact with the author by posing questions you may have about its contents.

Hints for Success

Because this book is essentially a step-by-step tutorial, it has a common side effect with tutorials of this type. After you finish a chapter and see that you have progressed further through the cabin project, you may wonder exactly what you just did and whether you could do it again without the help of the step-by-step instructions.

This feeling is a natural result of this type of learning tool, and you can do a couple of things to get beyond it:


	You can work through the chapter again. Doing so may seem tedious, but it will help you draw faster. You’ll be able to accomplish the same task in half the time it took you to do it the first time. If you do a chapter a third time, you’ll halve your time again. Each time you repeat a chapter, you can skip more and more of the explicit instructions, and eventually you’ll be able to execute the commands and finish the chapter by just looking at the figures and glancing at the text. In many ways, this process is like learning a musical instrument. You must go slowly at first, but over time and through practice, your pace will pick up.

	Another suggestion for honing your skills is to follow the course of the book but apply the steps to a different project. You might draw your own living space or design a new one. If you have a real-life design project that isn’t too complex, that’s even better. Your chances for success in learning AutoCAD, or any computer program, are greatly increased when you’re highly motivated, and a real project of an appropriate size can be the perfect motivator.



Ready, Set…

Even with some of the most knowledgeable and passionate teachers by my side, I remember how overwhelming it was to learn AutoCAD as a student in high school. With each command I learned, it seemed there were another five I had yet to learn—and that was before AutoCAD evolved into the sophisticated, Microsoft Windows–based, modeling and design platform it is today. Ironically, the biggest challenge to AutoCAD wasn’t learning the commands, but learning how to apply them in the most efficient way.

For several years, my personal mantra has been simple: to empower CAD professionals. While writing this book, I didn’t want to simply introduce a bunch of commands without also putting them in context and demonstrating how to apply them to efficiently create drawings. With each exercise building on the next, you’ll learn not only the individual commands, but also how everything snaps together as you produce a complete document set the same way industry professionals do. As the title says, there is “no experience required”—only an interest in the subject and a willingness to learn!





Chapter 1: Getting to Know AutoCAD

Opening either AutoCAD or AutoCAD LT for the very first time can be an intimidating experience. Faced with such an expansive collection of tools, settings, and more, where is one to start? To help you answer that question, this chapter will break down the many components of the user interface into manageable segments and introduce you to basic operations such as opening drawings. Even if you’ve used earlier versions of AutoCAD, you’ll still want to review this chapter to become acquainted with some of the changes from recent years.

Although the 2011 release does have some subtle user interface improvements, the interfaces are almost identical in AutoCAD and AutoCAD LT. Generally speaking, both platforms offer the same 2D drafting experience. (The biggest difference is that AutoCAD LT has no 3D capability. AutoCAD offers many powerful tools for modeling in 3D that are not found in AutoCAD LT. These tools are the topic of Chapter16, “Creating 3D Geometry,” and Chapter17, “Rendering and Materials.”) With so little separating the two platforms, for most purposes in this book I’ll refer to both interchangeably as AutoCAD unless otherwise specified.


	Opening a new drawing

	Becoming familiar with the AutoCAD and AutoCAD LT Application windows

	Modifying the display

	Displaying and arranging AutoCAD tools



Starting AutoCAD

[image: m0101.tif]
If you installed AutoCAD using the default settings for the location of the program files, start the program by choosing Start  Programs  Autodesk  AutoCAD 2011  AutoCAD 2011 or by choosing Start  Programs  Autodesk  AutoCAD LT 2011  AutoCAD LT 2011, depending on your program. (This command path might vary depending on the Windows operating system and scheme you are using.) You can also find and double-click the AutoCAD 2011 icon or the AutoCAD LT 2011 icon on your desktop.


[image: note.tif]
NOTE You can also use AutoCAD-based products such as AutoCAD Architecture or AutoCAD Civil 3D to learn the topics covered in this book. To use one of these vertical products, choose Start  Programs  Autodesk AutoCAD Product Name 2011  AutoCAD Product Name as AutoCAD 2011.



The Welcome Screen

The Welcome Screen, shown in Figure 1-1, opens when you first start AutoCAD and leads to several video tutorials and demonstrations. Within it you’ll find links to a number of videos introducing you to AutoCAD. These videos go beyond what’s found in the New Features Workshop by providing a more comprehensive look at the entire feature, not just what may have changed from previous releases. The dialog itself features videos for the most popular topics and contains links to many more resources, including additional tutorial videos.

The following links are found in the lower-left corner of the Welcome Screen:


	New Features Workshop: Links to the already mentioned New Features Workshop, where you can learn about improvements that were made throughout the last several releases.

	Learning Path: This link is truly a launch pad to all things AutoCAD, allowing you access to additional tutorials, tips, tricks, and even links to groups and blogs.

	More Videos: Expands on the videos featured inside the Welcome Screen itself, and provides access to many more videos to help you get started with AutoCAD.

	Online Help: An online version of the same help file that installs with the software Although the internal help file defaults to a local copy of the online help file if no internet connection is available, this link does not and requires an internet connection to use..




Figure 1-1: The Welcome Screen featuring videos and links to help you get started with AutoCAD
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After exploring the Welcome Screen, you may prefer to disable it from automatically loading each time you start the software. This can be done by deselecting the check box labeled Show This Dialog At Startup in the lower-left corner of the Welcome Screen. Even after choosing this option, you can still access the Welcome Screen through the Help button on the right end of the AutoCAD title bar.

Exploring the New Features Workshop

Among the options found on the Welcome Screen when AutoCAD first opens is a What’s New link (see Figure 1-1 earlier). This link leads you to the New Features Workshop (Figure 1-2), where you can quickly learn how AutoCAD 2011 has improved over the last several releases and which tools you can use to augment any skills you already have. In addition to the Welcome Screen, you can also find the New Features Workshop through the Help button on the right end of the AutoCAD title bar.

The New Features Workshop is split in two; an index of topics (new features) is listed along the left side of the interface, which is complemented by a pane displaying information about a selected topic on the right (see Figure 1-2). The drop-down list in the upper-left corner provides access to the New Features Workshops for other Autodesk products installed on your system.


Figure 1-2: The New Features Workshop dialog box

[image: f0102.tif]


The Customer Involvement Program

AutoCAD 2011 is among a large number of Autodesk products that provide the opportunity to participate in a customer involvement program (CIP). The CIP is designed to collect nonpersonal information about your Autodesk products and computer system to help the product programmers and developers design software that best meets your needs. If you haven’t yet agreed or declined to participate, the Customer Involvement Program dialog box (Figure 1-3) might prompt you to join when you first start AutoCAD.

Participation is strictly voluntary and, if you choose to participate, AutoCAD will periodically send a small file to Autodesk containing information such as your software name and version, the commands you use, and your system configuration information. An Internet connection is required, and you must ensure that your firewall settings don’t prevent the information from being transmitted.


Figure 1-3: The Customer Involvement Program dialog box

[image: f0103.tif]


Exploring the AutoCAD User Interface

Once you dismiss all of the initial dialog boxes, AutoCAD opens to display its default user interface, or UI as it’s sometimes called. Collectively known as the graphics window, the user interface can be broken down into numerous parts. Many of these parts remain unchanged regardless of how the software is configured, whereas other elements may not always be viewable. We’ll discuss how AutoCAD chooses to configure the user interface shortly. At this point, however, your graphics window should look similar to Figure 1-4.


AutoCAD and AutoCAD LT offer numerous dialog boxes with various combinations of buttons and text boxes. You’ll learn many of their functions as you progress throughout the book.



Standard AutoCAD Workspaces

AutoCAD provides the following standard workspaces:

2D Drafting & Annotation Utilizing the Ribbon, this workspace (shown in Figure 1-4) is considered the default workspace. Unless otherwise specified, this is also the workspace used throughout this book.

AutoCAD Classic Mimics the menu-based interface utilized prior to AutoCAD2009.

3D Basics Provides the core tools needed to get started with 3D modeling inside AutoCAD. (For AutoCAD users only. 3D features are not included in AutoCAD LT.)

3D Modeling Provides the complete set of 3D modeling tools found inside AutoCAD, including materials via the Materials Browser. (For AutoCAD users only. 3D features are not included in AutoCAD LT.)

Initial Setup Workspace You may have one or more Initial Setup Workspaces if you have completed the steps inside the Initial Setup dialog box one or more times.


Figure 1-4: The AutoCAD Application window using the 2D Drafting & Annotation workspace

[image: f0104.eps]


Switching the Current Workspace

Whether you choose to develop your own custom workspace or just use one that comes with the software, you may switch your current workspace at any time. As you become more comfortable with the software, you’ll likely choose to build a workspace that better matches the way you use AutoCAD. You’ll be using the 2D Drafting & Annotation workspace for the first 15 chapters in this book. In the final two chapters, you’ll switch to the 3D Modeling (Figure 1-5) workspace. For now, however, you need to get your AutoCAD user interface to look like Figure 1-4.


[image: note.tif]
NOTE The illustrations in this book show the drawing area of the AutoCAD user interface with a white background; however, the default and preferred method is to use a dark gray or black background to reduce eyestrain. The color choice in the book is simply for readability.




Figure 1-5: The AutoCAD Application window using the 3D Modeling workspace

[image: f0105.eps]


If your screen looks like Figure 1-5 or isn’t at all like Figure 1-4, you need to make a few changes:


1. Click the Workspace drop-down from the Quick Access toolbar, and choose 2D Drafting & Annotation, as shown in Figure 1-6. Alternatively, command-line users can enter:

WSCURRENT↵

2d drafting&annotation↵.


Figure 1-6: Selecting the 2D Drafting & Annotation workspace

[image: f0106.tif]


2. The 2D Drafting & Annotation workspace may display the tool palettes on the screen. If the palettes are displayed, you need to turn them off for now by clicking the X in the upper-right corner. Your workspace might have different palettes displayed than those shown in Figure 1-7. If other palettes are still visible, click the X in the upper-right or upper-left corner of each palette to close them.


Figure 1-7: The tool palettes

[image: f0107.tif]


3. The large area in the middle of the screen is called the drawing area. It might need to be adjusted. On the Ribbon, select the View tab  Visual Styles panel  Visual Styles drop-down list, and select the 2D Wireframe option (see Figure 1-8).


Figure 1-8: Selecting the 2D Wireframe visual style

[image: f0108.tif]



AutoCAD LT users can skip step 3 and move on to step 4.



4. If you’re not still on the View tab, click the View tab  Views panel  Top, as shown in Figure 1-9. This procedure ensures that your view is perpendicular to the drawing area. It should be as though you were looking straight down at a piece of paper on a drawing table.

If the drawing area looks like a sheet of graph paper, it means the grid, a drawing aid that you’ll look at later, is turned on.


Figure 1-9: Selecting the Top option from the Views Ribbon panel
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5. Move the cursor to the left side of the status bar at the bottom of the screen, and click the Grid Display button so it’s in the Off (unpushed with a gray, not blue background) position and the gridlines disappear. Place your cursor over any button in the status bar to reveal its name in a tooltip.



Your screen should now look similar to Figure 1-4.

Introducing the AutoCAD Application Window

At the top of the Application window (see Figure 1-10) the Ribbon and the Quick Access toolbar sit to the left, and the InfoCenter and a number of related tools sit on the right.

The title bar is analogous to the title bar in any Windows program. It contains the program name (AutoCAD or AutoCAD LT) and the title of the current drawing with its path, provided a drawing other than the default Drawing#.dwg is open. Below the title bar is the Ribbon, where you’ll find most of the AutoCAD commands and tools needed to complete any drawing task. You’ll explore the Ribbon in much more detail shortly; however, its basic concept is that related tasks are found under the different tabs, which are further segmented into panels containing similar tools.
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The title bar and menu bar at the top of the AutoCAD LT screen are identical to those in AutoCAD except that AutoCAD LT appears in the title bar rather than AutoCAD.



Figure 1-10: The Ribbon, Quick Access toolbar, and InfoCenter

To the far right of the title bar is the InfoCenter containing the Search, Subscription Center, Communication Center, Favorites, and Help buttons. You can enter a question in the field to the left of the Search button to access information from a number of locations including the standard AutoCAD help system quickly through the drop-down panel. With the Communication Center, you can choose to have information, such as software updates, product support, or websites such as blogs using Really Simple Syndication (RSS) feeds, sent directly to your system. With the Favorites tool, you can define a list of help or informational topics that can be quickly accessed whenever you need them. The Help button is a direct link to the AutoCAD help system (also accessible by pressing the F1 key).

The blank middle section of the screen is called the drawing area. Notice the movable crosshair cursor (see Figure 1-11). The crosshairs on your cursor might extend completely across the screen. Later in this chapter, you’ll see how to modify the length of the crosshairs as well as make a few other changes.


Figure 1-11: The crosshair cursor placed near the UCS icon

[image: f0111.tif]


Notice the little box at the intersection of the two crosshair lines. This is one of several forms of the AutoCAD cursor, known in this form as the Aperture. When you move the cursor off the drawing area, it changes to the standard Windows pointing arrow. As you begin using commands, it will take on other forms, depending on which step of a command you’re performing.

The icon composed of two lines, labeled X and Y, in the lower-left corner of the drawing area is the UCS icon (UCS stands for user coordinate system). It indicates the positive direction for the x- and y-axes.

Below the drawing area is the command window, shown in Figure 1-12.


The number of InfoCenter icons may vary based on the way AutoCAD was installed, especially in the case of network deployments.




Understand Where AutoCAD Is Searching

It’s reasonable to assume a search query would return the same results regardless of where in the software the search was performed. However, that is not the case. A search using the InfoCenter will generally yield more results than a search of the AutoCAD help file. The InfoCenter is able to search numerous locations simultaneously.

By default the InfoCenter will search the help file as well as some predetermined web locations. You can view and customize the full list of where the InfoCenter searches by clicking the down arrow next to the binocular icon and selecting Search Settings.




Figure 1-12: The command window

[image: f0112.tif]


Most commands can be launched in a few different ways (the command line, Ribbon tools, and so on). Regardless of which method you choose, the command window is where you will tell the program what to do and where the program tells you what’s happening. It’s an important feature, and you’ll need to learn how it works in detail. By default, three lines of text are visible. You’ll learn how to adjust the number of visible lines later in this chapter during the “Working in the Command Window” section. When the Dynamic Input feature is active, much of the command window information is displayed alongside the cursor as well.

Below the command window is the status bar (see Figure 1-13).


Figure 1-13: The left side of the status bar (top) and the right side of the status bar (bottom)
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On the left end of the status bar, you’ll see a coordinate readout window. In the middle are 14 buttons (LT has only 11) that activate various drawing modes. It’s important to learn about the coordinate system and most of these drawing aids (Snap Mode, Grid Display, Ortho Mode, Object Snap, and so on) early as you learn to draw in AutoCAD. They will help you create neat and accurate drawings. You’ll have the chance to explore each of the following drawing modes/aides throughout this book; as a preview, however, following is a complete list with a brief description of each:
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Infer Constraints When this is enabled, AutoCAD will automatically apply constraints between objects as you create or modify them.
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Snap Mode Restricts movement of the cursor inside the drawing area to specified intervals.
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Grid Display Mimics a piece of graph paper by displaying a series of nonplotting horizontal and vertical lines displayed in the drawing’s background.
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Ortho Mode Restricts movement of the cursor to 90° intervals; 0°, 90°, and 270° by default.

[image: m0108.tif]
Polar Tracking Frequently used in conjunction with Object Snap Tracking, Polar Tracking is an advanced drawing tool that guides cursor movement to specified increments along a polar angle. Its use will be introduced in Chapter 5, “Developing Drawing Strategies: Part 2.”
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Object Snap Aids you in drawing objects based with geometric reference points such as endpoint, midpoint, intersection, and so on. Mastering the use of object snaps is critical in the creation of accurate drawings.
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3D Object Snap Similar to the standard object snaps, with more sophisticated tools for working and interacting with 3D faces and edges.
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Object Snap Tracking An advanced drafting method introduced in Chapter 5, this allows you to draw objects with specific geometric relationships to other objects within your drawing.
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Dynamic UCS UCS stands for User Coordinate System, and Dynamic UCS is used in 3D drawings.
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Dynamic Input When enabled, displays much of the command interface near the cursor (in addition to the command line itself).
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Show/Hide Lineweight Toggles the display of lineweights (discussed in Chapter14, “Using Layouts to Set Up a Print”) in the drawing area.
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Show/Hide Transparency Many objects, including layers, can be assigned a transparency value. When this toggle is on, these objects’ transparency settings will take effect.
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Quick Properties Based on the type of object/objects you have selected, Quick Properties provides a contextual version of the full Properties palette near the selected object/objects. When nothing is selected, the Quick Properties will disappear from the drawing area.
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Selection Cycling Provides contextual list of selected overlapping objects, making it easier to select the object/objects you intended to select.


Text-Based Buttons or Icons?

Sometimes the status bar icons can be a little cryptic. If you prefer, AutoCAD can display those buttons as text instead of icons.


[image: g0102.tif]


Just right-click on any of the icons, and deselect Use Icons.
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At the right side of the status bar are tools for navigating in the drawing area and controlling the display, tools for controlling the appearance of annotation objects in AutoCAD, and tools to control access to other drawings or features within the current drawing. The padlock icon controls which types of toolbars and windows are locked in their current positions on the screen. Leave it in the unlocked mode for now.

To conclude this quick introduction to the various parts of the Application window, you need to understand a couple of items that might be visible on your screen. You might have scroll bars below and to the right of the drawing area; although they can be useful, they can also take up precious space in the drawing area. They won’t be of any use while working your way through this book, so you can remove them for now.

These features can be removed temporarily from the OPTIONS command. The following steps will show you how:
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1. To access the OPTIONS command graphically, click the Application Menu button in the upper-left corner of the AutoCAD window, and then click the Options button at the bottom of the menu (see Figure 1-14). The OPTIONS command is also accessible from the command line by entering OPTIONS↵.


Figure 1-14: Click the Options button in the Application menu.

[image: f0114.tif]


The Options dialog box (shown in Figure 1-15) opens. It has ten tabs (LT has only eight) across the top that act like tabs on file folders.

2. Click the Display tab, which is shown in Figure 1-16. Focus on the Window Elements section. If scroll bars are visible on the lower and right edges of the drawing area, the Display Scroll Bars In Drawing Window check box will be selected.

3. Click the check box to turn off the scroll bars. Also be sure the check box for Display Screen Menu is not selected. Don’t click the OK button yet.




Figure 1-15: The Options dialog box
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Figure 1-16: The Options dialog box opened at the Display tab
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AutoCAD LT doesn’t have the screen menu, so the option to turn it off isn’t on LT’s Display tab.



Another display setting that you might want to change at this point controls the color of the cursor and the drawing area background. If you want to change the colors, follow these steps:


1. In the Window Elements area of the Display tab, click the Colors button to open the Drawing Window Colors dialog box (see Figure 1-17). In the upper-left corner of the dialog box, in the Context list box, 2D Model Space should be selected. If it’s not, select it.


[image: note.tif]
NOTE The screen-captured images in this book are taken from AutoCAD sessions using the Dark color scheme. You can set the Color Scheme at the top of the Window Elements area and choose either Light or Dark.



2. Move to the Color drop-down list, which is in the upper-right corner. If your drawing area background is currently white, a square followed by the word White is displayed. Open the Color drop-down list and select Black (or the background color you want). The drawing area will become that color, and the cursor color will change to white, as shown in the Preview window in Figure 1-17.


Figure 1-17: The Drawing Window Colors dialog box
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Alternatively you can click the Restore Classic Colors button to set the background to black, along with the other display contexts.



3. Click the Apply & Close button to close the Drawing Window Colors dialog box. The background and cursor colors will change.

4. If you want to change the length of the lines of your crosshair cursor, go to the lower-right corner of the Display tab (the middle of the right side for LT), and move the slider to change the Crosshair Size setting. The crosshair length changes as a percentage of the drawing area.
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5. Click OK to apply any remaining changes, and close the Options dialog box.
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TIP If you choose a color other than black as the drawing area background color, the color of the crosshair cursor remains the same as it was. To change the crosshair color, go to the Interface Element list box in the Drawing Window Colors dialog box and select Crosshairs. Then select a color from the Color drop-down list.



Working in the Command Window

Just below the drawing area is the command window. This window is separate from the drawing area and behaves like a Windows window — that is, you can drag it to a different place on the screen and resize it, although you probably shouldn’t do this at first. If you currently have fewer than three lines of text in the window, you should increase the window’s vertical size. To do so, move the cursor to the horizontal boundary between the drawing area and the command window until it changes to an up-and-down arrow broken by two parallel horizontal lines.

Hold down the left mouse button, drag the cursor up by approximately the same amount that one or two lines of text would take up, and then release the mouse button (see Figure 1-18). You should see more lines of text, but you might have to try this a few times to display exactly four lines. A horizontal line will separate the top two lines of text from the bottom line of text. When you close the program, AutoCAD will save the new settings. The next time you start AutoCAD, the command window will display four lines of text.

The command window is where you give information to AutoCAD and where AutoCAD prompts you for the next step in executing a command. It’s a good practice to keep an eye on the command window as you work on your drawing. Many errors can occur when you don’t check it frequently. If the Dynamic Input button on the status bar is in the On position, some of the information in the command window will appear in the drawing area next to the cursor. You’ll learn about this feature when you start drawing.


Figure 1-18: Resizing the command window
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Before you begin to draw in the next chapter, take a close look at the Ribbon, Application menu, toolbars, and keyboard controls.


[image: note.tif]
NOTE You can start AutoCAD commands in a number of ways: from the Ribbon, the Application menu, the command window, and the menus that appear when you right-click. When you get used to drawing with AutoCAD, you’ll learn some shortcuts that start commands quickly, and you’ll find the way that best suits you.



Using the Ribbon

Perhaps one of the most prominent elements of the AutoCAD interface is the Ribbon (Figure 1-19). While the Ribbon can be positioned in a number of different ways, its default position extends across the top of the AutoCAD window. Depending on the size of your AutoCAD window (or current screen resolution), the Ribbon may look a little different on your computer. That’s because the Ribbon self-adjusts according to the size of the AutoCAD window itself. To see the Ribbon in its fully expanded state, you need to be sure to have a screen resolution wider than 1280 pixels. When the width is too narrow to display each panel fully, the panels will begin to collapse first by replacing the panels with a single button bearing the name of the panel.

The Ribbon itself can be divided into three parts: tools, panels, and tabs.

Ribbon Tools The individual icons and various drop-down lists found on the Ribbon are known as Ribbon tools. Clicking on any of these tools will launch the command associated with it.
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Figure 1-19: The Ribbon fully displaying all panels (top) and with partially and completely collapsed panels (bottom)
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Ribbon Panels Similar tools are grouped together into a series of Ribbon panels. For instance the Move, Erase, and Rotate tools modify objects. Consequently, each of these tools is found on the Modify Ribbon panel.
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Ribbon Tabs Ribbon tabs offer the highest level of organization; they group Ribbon panels by task. For instance, commands related to plotting (printing) are found on the Output tab, whereas commands related to entering text can be found on the Annotate tab.
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Displaying the Ribbon Tools

The Ribbon’s default location is at the top of the screen, but it can be moved or docked almost anywhere on your screen. Individual panels have a number of display options built into them as well. In the following exercises, you will have the chance to explore many of these display options.

Collapsing, Moving, and Hiding the Ribbon

[image: m0120.tif]
Available drawing area is always at a premium, and you can regain some of it by collapsing the Ribbon. When you click the Minimize button to the right of the Ribbon tabs once, the panels are collapsed vertically, showing only an icon for each Ribbon panel. Clicking it a second time collapses the Ribbon further so only the tab and panel names display. Clicking it a third time collapses the Ribbon so only the tabs show. When the Ribbon is in either of these states, you can expand any panel or tab by clicking its visible panel or tab name. Clicking the Minimize button a fourth time returns the Ribbon to its default state.

Rather than cycling through each display option, you can use the small Down icon to the right of the Minimize Ribbon button to quickly switch between states. A list of available display states (Figure 1-20) will appear after clicking the Down icon. Select the desired visibility to switch directly to it, as opposed to cycling through the other options.


Figure 1-20: List of available Ribbon display states
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The Ribbon’s default location is at the top of the screen, but it can be undocked, or floating over the drawing area; or it can be moved to a second monitor, or docked on either side of the drawing area. To undock the Ribbon, right-click to the right of the tab names and choose Undock from the pop-up menu, as shown in Figure 1-21.

The Ribbon detaches from the top of the drawing area and floats on the screen, as shown in Figure 1-22. To dock it, click the title bar on the side of the floating Ribbon and drag it to the side or the top of the drawing area. Experiment with detaching the Ribbon, but when you are finished, dock it back at the top so that you can follow the graphics in this book more easily.


Figure 1-21: Undocking the Ribbon
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If you don’t want the Ribbon at all, you can turn it off by right-clicking to the right of the Ribbon tabs and choosing Close. To turn it on, enter RIBBON↵. You’ll use the Ribbon throughout this book, so be sure to keep it on for now.


Figure 1-22: The Ribbon undocked from the top of the drawing area
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Using the Ribbon Tools

Each panel contains tools from a related family of functions. For example, all the common tools for editing objects in the drawing area are consolidated in the Modify panel. When more tools are available than will fit on the panel, an arrow is displayed on the panel’s title bar. Clicking the title bar expands the panel and exposes the additional tools. Follow these steps to learn how the Ribbon tools work and how they display information.


1. Click the Home tab on the Ribbon to expose the Home tab’s panels (see the top of Figure 1-19 shown earlier).
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2. Move your cursor over the Modify panel, and pause the cursor over the Bring To Front tool button.

This exposes the button’s tooltip, as shown at the top of Figure 1-23. Displaying the name of the tool, the tooltip also provides a brief description of its function, the command-line equivalent of clicking the tool, and instructions to press the F1 key to open the AutoCAD Help file to the current tool’s Help page.


Figure 1-23: The tooltip for the Bring To Front command (top) and the extended tooltip (bottom)
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3. After a few seconds of hovering over the Bring To Front button, the tooltip expands to display the extended tooltip (see the bottom of Figure 1-23) with a more complete description.
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4. Pause the cursor over the Copy button in the Modify panel. This time, after a few seconds, the tooltip is replaced with a cue card, as shown in Figure 1-24, instead of an extended tooltip. Cue cards show the step-by-step implementation of the tool.

5. Click the Modify panel’s title bar to expand the panel and expose all of the Modify tools.
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6. Often, you may find yourself returning to the same tool on an expanded Ribbon panel. When that happens, you can pin the panel open by clicking the pushpin-shaped button in the bottom-left corner. When the panel is pinned open, it remains open even when the cursor is not hovering over it (see Figure 1-25).
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7. Click the button again to unpin the panel, and then move the cursor off the panel to collapse it. Regardless of whether a panel is pinned or unpinned, it will automatically collapse if you change Ribbon tabs.




Figure 1-24: The cue card for the Copy tool
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Figure 1-25: The Modify panel pinned to stay open
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Customizing the Ribbon

Nearly every portion of the Ribbon can be customized to your liking. From modifying an existing Ribbon panel to building your own custom tabs and panels, to displaying only the buttons you want — it’s all possible! There are several ways to customize the Ribbon, and the overall user interface. One of the easiest ways to custom tailor the user interface to the way you plan to use AutoCAD is with the Initial Setup Dialog box.

The Initial Setup Dialog Box

To access the Initial Setup dialog box, select the Application Menu button (the big A icon in the upper-left corner of the screen), and then select Options. This opens the Options dialog box, where you can select the User Preferences tab and then click the Initial Setup button. Finally the Initial Setup dialog box (Figure 1-26) will appear prompting you to select an industry that most closely describes your work. After progressing through the Initial Setup Dialog, the software will custom tailor itself to better match the way people in your industry use AutoCAD. For instance, if you were to select Architecture, AutoCAD would customize your Ribbon panels and tool palettes, and it might also make changes to settings such as the default drawing template path.


Figure 1-26: The first Initial Setup dialog box
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Because so many configurations are possible when using this tool, click the Skip button if you open the Initial Setup dialog box. Staying with a generic setup will help ensure AutoCAD will both look and perform as shown in this book. Choosing the Skip button will open the Initial Setup - Changes Not Saved dialog shown in Figure 1-27 where you can Return to Initial Setup or Discard changes and close Initial Setup. To ensure AutoCAD looks and performs as shown in this book, choose Discard changes and close Initial Setup.

Using the Initial Setup Dialog box is just one way to customize the look and feel of AutoCAD. More advanced features such as the Customize User Interface (CUI command) allow you to customize nearly every element of the user interface. You can even design your own buttons for commands that aren’t already represented by buttons on the toolbars. These activities are for more advanced users, however, and aren't covered in this book. There are numerous resources available online from blogs, such as your author’s www.TheCADGeek.com. George Omura’s book Mastering AutoCAD 2011 and AutoCAD LT 2011 (Wiley, 2010) provides a comprehensive look into customizing the Ribbon and more.


Figure 1-27: The second Initial Setup dialog box
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Using the Application Menu

The Application menu contains the tools for opening, saving, and printing (plotting) your drawings, similar to the options found under the File drop-down menu in AutoCAD and many other programs. When the Application menu is open, the menus for these tools project from the upper-left corner of the AutoCAD window and cover the drawing area and any open dialog boxes.
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1. Click the Application Menu button to open the Application menu.


Be careful not to double-click the Application menu, as this will make AutoCAD close.



2. The left pane of the Application menu displays the different commands. Clicking or hovering over a command displays a menu of its options in the right pane, as shown in Figure 1-28.



A bar with an up or down arrow at the top or bottom of the right pane indicates that additional tools are available. You can display these tools by placing your cursor over either bar.


Figure 1-28: The Application menu showing the Print options
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Opening a Drawing with the Application Menu

The Application menu offers a quick method for opening drawings. You can even see a thumbnail preview of the drawings and arrange drawings that you frequently edit so that they are easily accessible. Here’s how:


1. To open a new AutoCAD file from the Application menu, select New Drawing, as shown in Figure 1-29.

This opens the Select Template dialog box, where you select a template on which to base the new drawing. Opening a file with a template is covered in Chapter 2, “Learning Basic Commands to Get Started.”


Figure 1-29: Opening a new drawing from the Application menu
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2. To open an existing file from the Application menu, select Open  Drawing, as shown in Figure 1-30.


Figure 1-30: Opening an existing drawing from the Application menu
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This opens the Select File dialog box, where you can navigate to the desired drawing file and select it.
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3. To open a file that you’ve worked on recently, click the Recent Documents button at the top of the Application menu’s left pane. This displays the most recent files opened in AutoCAD in the right pane, as shown in Figure 1-31.


Figure 1-31: Displaying the recent documents in the Application menu
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4. Hover over a filename in the right pane to display a thumbnail preview of the drawing and additional information, including the drawing location and AutoCAD drawing format (see Figure 1-32).




Figure 1-32: Displaying a thumbnail of the selected file
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Opening New Files

You can open new or existing files using the QNew or Open button in the Quick Access toolbar. Existing drawings can also be opened by dragging them from a Windows Explorer window to the AutoCAD title bar.
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Getting the Most out of the Recent Documents List

The Application menu offers many time-saving tips. Here are two of the best ways to use the Recent Documents list:


	Frequently Used Drawings: For drawings you access on a regular basis, and would like to remain on the Recent Documents list, click the pushpin that displays next to its name. This will “pin” that drawing to the Recent Documents list until you unpin it.

	Maximize the Number of Recent Documents: Out of the box the Recent Document list only displays the last nine drawings you’ve opened. This number can be increased to fifty by opening the OPTIONS command, selecting the Open and Save tab, and changing the Number Of Recently-Used Files setting under the Application Menu heading.
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NOTE AutoCAD 2011 uses the AutoCAD 2010 drawing (DWG) file format. This means that the files created in AutoCAD 2011 are compatible only with AutoCAD 2010 and AutoCAD 2011. You can share drawings with releases earlier than AutoCAD 2010 by performing a simple conversion. To convert a 2010 format drawing to a prior version, open the Application menu and then click Save As  AutoCAD Drawing and choose the version you want from the Files Of Type drop-down list at the bottom of the Save Drawing As dialog box.
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Switching between Open Drawings

As in many programs, you can have multiple drawing files open in the same session of AutoCAD. Each drawing is stacked behind the drawings in front of it. There are several ways to switch between the open files, including using the Application menu, as shown next.


1. Start or open two or more AutoCAD files.
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2. Open the Application menu, and then click the Open Documents option at the top of the left pane. The open drawings are displayed in the right pane, as shown in Figure 1-33.

3. Click on any drawing to bring it to the front of the AutoCAD window.


Figure 1-33: Displaying the open drawings in the Application menu
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4. You can change the way AutoCAD displays the list of open drawings by clicking the icon near the top of the right pane and choosing one of four sizes of icons or thumbnail images to represent the open drawings.
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5. Another option for switching between open drawings is to click the Quick View Drawings button in the status bar. This displays thumbnails for the open drawings, and you can click any thumbnail to make its drawing active. Hovering over a thumbnail displays that drawing’s layouts (see Figure 1-34). Layouts are designated views of the drawing with scaled viewports looking into the drawing model. Viewports are covered in Chapter 14.




Figure 1-34: Displaying the open drawings with the Quick View Drawings tool
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Using the Drop-Down Menus

If you prefer to use drop-down menus, they’re still available in AutoCAD 2011, although they are turned off by default in the 2D Drafting & Annotation, 3D Basics, and 3D Modeling workspaces. You can display them by switching to the AutoCAD Classic workspace, clicking the down arrow at the right end of the Quick Access toolbar, and choosing Show Menu Bar (see Figure 1-35), or by entering MENUBAR↵1↵. This book will focus on the use of the Ribbon; the menus are covered here so that you’ll be familiar with them if you use them in the future.


Figure 1-35: Turning on the menu bar
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The left end of the menu bar, just below the title bar (see Figure 1-36), consists of an icon and 13 (11 if you don’t have the Express Tools installed or are using LT) menus. Click any of these to display a drop-down menu. The icon and the File and Edit menus are included with all Windows-compliant applications, although they are somewhat customized to work with AutoCAD. The drop-down menu associated with the icon contains commands to control the appearance and position of the drawing area.


Figure 1-36: The AutoCAD user interface showing the menu bar
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Commands in the File menu are for opening and saving new and existing drawing files, printing, exporting files to another application, choosing basic utility options, and exiting the application. The Edit menu contains the UNDO and REDO commands, the Cut and Paste tools, and options for creating links between AutoCAD files and other files. The Help menu works like most Windows Help menus and contains a couple of AutoCAD-specific entries as well, including some online resources and a link to the New Features Workshop.

The other eight (or ten) menus contain the most frequently used AutoCAD commands. You’ll find that if you master the logic of how the commands are organized by menu, you can quickly find the command you want. Here are short descriptions of the other AutoCAD drop-down menus:

View Contains tools for controlling the display of your drawing file.

Insert Contains commands for placing drawings and images or parts of them inside other drawings.

Format Contains commands for setting up the general parameters for a new drawing or changing the entities in a current drawing.

Tools Contains special tools for use while you’re working on the current drawing, such as those used for finding the length of a line or for running a special macro.

Draw Contains commands for creating new objects (such as lines or circles) on the screen.

Dimension Contains commands for dimensioning and annotating a drawing.

Modify Contains commands for changing existing objects in the drawing.

Parametric Contains commands for constraining objects or dimensions to specific values or parameters.

Window Contains commands for displaying currently open drawing windows and lists currently open drawing files.

Express Contains a library of productivity tools that cover a wide range of AutoCAD functions. Express Tools are widely used but aren’t officially supported by Autodesk. They are a part of the default program installation but may be omitted in a custom installation. AutoCAD LT users do not have the option to install Express Tools.

You can turn off the menu bar by clicking the down arrow on the right end of the Quick Access toolbar and choosing Hide Menu Bar, or by entering MENUBAR↵0↵.

Using the Toolbars

The AutoCAD toolbars have essentially been replaced by the Ribbon or other features, so we’ll only touch on them briefly here. Toolbars, like the Ribbon panels, are collections of tools grouped by similar tasks. Like the Ribbon itself, any toolbar can be displayed or hidden without affecting the others, and they can all be docked to a side or the top of the drawing area or float freely. To display a toolbar, first display the menu bar; then choose Tools  Toolbars, click a toolbar category, and click the toolbar that you want to open (see Figure 1-37).

Take a few minutes to explore the available toolbars, and then close them and hide the display of the menu bar. You’ll touch on a few of the toolbars throughout the course of this book, but most of the tools used will be accessed from the Ribbon.


Figure 1-37: Selecting a toolbar to display

[image: f0137.tif]


Workspaces

You haven’t been directed to make any significant changes to the workspace, but when you do, you can save this setup as a new workspace. Using this feature, you can always return to your preferred layout by activating the saved layout. Follow these steps:


1. Click the Workspace Switching drop down list next to the Application menu, or on the right side of the status bar, and choose Save Current As from the menu, as shown on the left in Figure 1-38. This opens the Save Workspace dialog box, shown on the right in Figure 1-38.


Figure 1-38: The Save Workspace dialog box

[image: f0138a.tif]
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2. Enter a name for the workspace and click Save. The dialog box closes, and you are returned to your workspace. Until you change it or select a different workspace, the new workspace setup will remain as it is now.



When you make changes to the new workspace by adding a toolbar or changing the background color of the drawing area, you can easily update the current workspace to accommodate those changes. Follow steps 1 and 2, naming the workspace again with the same name. You’ll get a warning window telling you that a workspace by that name already exists and asking you whether you want the new arrangement to replace the old one. Click Yes.

Using the Keyboard

The keyboard is an important tool for entering data and commands. If you’re a good typist, you can gain speed in working with AutoCAD by learning how to enter commands from the keyboard. AutoCAD provides what are called alias commands — single keys or key combinations that start any of several frequently used commands. A good example of a command alias that ships with AutoCAD is the LINE command. Of course you could enter LINE at the command line to launch the command, but typing the one-character alias L is much quicker and easier. You can add more aliases or change the existing ones as you become more familiar with the program.

In addition to the alias commands, you can use several of the F keys (function keys) on the top row of the keyboard as two-way or three-way toggles to turn AutoCAD functions on and off. Although buttons on the screen duplicate these functions (Snap, Grid, and so on), it’s sometimes faster to use the F keys.

While working in AutoCAD, you’ll need to enter a lot of data, such as dimensions and construction notes; answer questions with “Yes” or “No”; and use the arrow keys. You’ll use the keyboard constantly. It might help to get into the habit of keeping your left hand on the keyboard and your right hand on the mouse if you’re right-handed, or the other way around if you’re left-handed.

Using the Mouse

Your mouse most likely has two buttons and a scroll wheel. So far in this chapter, you have used the left mouse button to choose menus, commands, and options, and you’ve held it down to drag the Ribbon. The left mouse button is the one you’ll be using most often, but you’ll also use the right mouse button.

While drawing, you’ll use the right mouse button for the following three operations:


	To display a menu containing options relevant to the particular step you’re in at the moment

	To use in combination with the Shift or Ctrl key to display a menu containing special drawing aids called object snaps

	To display a menu of toolbars when the pointer is on any icon of a toolbar that is currently open



The middle button with scroll wheel serves a dual function. Pressing-and-holding the middle button will allow you to pan throughout your drawing until you release the middle button. The second function of the middle scroll wheel is to zoom in/out within your drawing. When scrolling toward the screen, you will zoom into your drawing. Conversely, when scrolling away from the screen, you will zoom out from your drawing.

AutoCAD makes extensive use of toolbars and the right-click menu feature. This makes your mouse an important input tool. The keyboard is necessary for inputting numeric data and text, and it has hot keys and aliases that can speed up your work; however, the mouse is the primary tool for selecting options and controlling toolbars.

The next chapter will familiarize you with a few basic commands that will enable you to draw a small diagram. If you want to take a break and close AutoCAD, choose Application Menu  Exit AutoCAD (lower-right corner), and choose not to save the drawing.

Are You Experienced??

Now you can…


	recognize the elements of the AutoCAD Application window

	understand how the command window works and why it’s important

	start commands from the Ribbon

	start commands from the command line

	use the Application menu

	display the drop-down menus

	open and control the positioning of toolbars

	save a workspace of your screen setup in AutoCAD







Chapter 2: Learning Basic Commands to Get Started

Now that you’ve taken a quick tour of the AutoCAD and AutoCAD LT screens, you’re ready to begin drawing! This chapter will introduce you to some basic commands used in drawing with AutoCAD and AutoCAD LT. To get you started, this chapter will guide you through the process of drawing a simple shape (see Figure 2-1).

You will need to use only five or six commands to draw the box. First, you’ll become familiar with the LINE command and how to draw lines at a specific length. Then I’ll go over the strategy for completing the form.


	Understanding coordinate systems

	Drawing your first object

	Erasing, offsetting, filleting, extending, and trimming objects in a drawing



Using the Line Command

In traditional architectural drafting, lines were often drawn to extend slightly past their endpoints (see Figure 2-2). Today we have entire applications that can open a CAD drawing and not only apply this effect, but make the drawing look hand drawn. A popular application for applying such an effect is Autodesk Impression. I won’t be covering Autodesk Impression in this book; however, you can visit http://autodesk.com/impression to learn more about it.


Figure 2-1: The shape you’ll draw

[image: f0201.tif]


The LINE command draws a straight line segment between locations on existing objects, geometric features, or two points that you can choose anywhere within the drawing area. You can designate these points by left-clicking them on the screen, by entering the x- and y-coordinates for each point, or by entering distances and angles from an existing point. After you draw the first segment of a line, you can end the command or draw another line segment beginning from the end of the previous one. You can continue to draw adjoining line segments for as long as you like. Let’s see how this works.

To be sure that you start with your drawing area set up the way it’s set up for this book, expand the Application menu (the red A button in the top-left corner of the AutoCAD user interface), and then choose Close  All Drawings to close any open drawings. The Application menu is shown in Figure 2-3.

[image: m0201.tif]
Like many other Windows-based programs, AutoCAD provides many ways you can close drawings individually as well. The first and perhaps most popular way is to click the X icon in the upper-right corner of any drawing next to the Minimize and Restore icons. The Quick View Drawings feature found on the AutoCAD status bar also features a similar X icon from which drawings may be closed individually. Drawings can also be closed from the Application menu by choosing Close  Current Drawing. Finally, if you’re an aspiring keyboard warrior, press both the Ctrl + F4 key at the same time to close the current drawing.


Figure 2-2: The shape drawn with overlapping lines

[image: f0202.tif]



Figure 2-3: Use the Application menu to close any open drawings.
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As shown in Figure 2-4, once you no longer have any drawings open, your drawing area will be a gradient gray and blank with no crosshair cursor; the Ribbon will disappear and only three buttons will remain in the Quick Access toolbar area on the left side of the title bar (along with the three informational buttons in the Quick Access toolbar). 


Figure 2-4: The AutoCAD user interface without any drawings open.
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Now follow these steps to begin using the LINE command:

[image: m0202.tif]

1. Click the New button at the left end of the Quick Access toolbar. In the Select Template dialog box, select the acad.dwt file, if it’s not already selected, and click Open, as shown in Figure 2-5. The menus, crosshair cursor, and toolbars return, and you now have a blank drawing in the drawing area.


[image: note.tif]
NOTE DWT files are drawing templates with several parameters, such as dimension styles, layers, plotting settings, and more already set.



2. On the left side, some of the tools, such as Object Snap and Dynamic Input, are turned on while others remain off. Make sure that Polar Tracking, Object Snap, Object Snap Tracking, Allow/Disallow Dynamic UCS, and Dynamic Input are turned on and all the others are turned off. You can identify the buttons by pausing over each and exposing its tooltip. Your toolbar should look similar to Figure 2-6.


Figure 2-5: Choose the acad.dwt template in the Select Template dialog box.
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Figure 2-6: The toolbar as it has been set up
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3. From the Home Ribbon tab  Draw panel, click the Line tool. Look at both the bottom of the command window and your cursor. Because Dynamic Input is turned on, prompts such as this one display both at the command line and next to the cursor (see Figure 2-7).


[image: tip.tif]
TIP You can also start the Line by typing LINE or L and pressing the Enter key, space bar, or the right mouse button.



The prompt now tells you that the LINE command is started (Command:_line) and that AutoCAD is waiting for you to designate the first point of the line (Specify first point:).


Figure 2-7: Both the command prompt and the cursor change to reflect the current command.
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4. Move the cursor onto the drawing area, and notice that the small box at the intersection of the crosshairs is not there.

When the cursor is used to select objects, the default condition, the pickbox appears in the cursor. When the cursor is used to designate a point, the pickbox is not visible. Using the left mouse button, click a random point in the drawing area to start a line.

5. Move the cursor away from the point you clicked and notice how a line segment appears that stretches like a rubber band from the point you just picked to the cursor. The line changes length and direction as you move the cursor, and these values are shown as input boxes in the drawing area.

6. Look at the command window again and notice that the prompt has changed (see Figure 2-8).

It’s now telling you that AutoCAD is waiting for you to designate the next point (Specify next point or[Undo]:).

7. Continue picking points and adding lines as you move the cursor around the screen (see Figure 2-9). After you draw the second segment, the command window repeats the Specify next point or[Close/Undo]: prompt each time you pick another point. The Dynamic Input fields and command prompt appear near the cursor, showing the angle and distance from the last point selected.

8. When you’ve drawn six or seven line segments, press Enter (↵) to end the LINE command. The cursor separates from the last drawn line segment.



The command prompt has returned to the bottom line. This tells you that no command is currently running.


Figure 2-8: The command prompt changes for the next point, and the line’s length and direction are shown in the drawing area.
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Figure 2-9: Drawing several line segments

[image: f0209.tif]



[image: tip.tif]
TIP The Enter (↵) key exits the LINE command and several others. Another option is to right-click and choose Enter from the context menu. This may require an extra step, but it may still be faster because your eyes never leave the screen. When you’re not entering data, the spacebar also acts like the Enter (↵) key and executes a command.



In this exercise, you used the left mouse button to click the Line button on the Ribbon and also to pick several points in the drawing area to make the line segments. You then pressed Enter (↵) on the keyboard to end the LINE command.


[image: note.tif]
NOTE In the exercises that follow, the Enter symbol (↵) will be used. When I say to “type” or “enter” something, it means to type the data that follows the word type or enter and then to press the Enter key (↵). For example, rather than writing “type L and press the Enter key,” I’ll write “enter L↵.” Finally, although I’ll capitalize the names of AutoCAD commands, be aware that commands are not case sensitive and may be entered however you wish.



Using Coordinates

A coordinate system consists of numbered scales that identify an initial, or base, point and the direction for measuring subsequent points on a graph. The Cartesian Coordinate System, named after the philosopher René Descartes, who defined the xy-coordinate system in the 1600s, consists of three numbered scales, called the x-axis, y-axis, and z-axis, that are perpendicular to each other and extend infinitely in each direction. As illustrated in Figure 2-10, each pair of axes (xy, xz, yz) forms a flat plane. Most of your time using AutoCAD will be spent drawing in the xy-plane.


Figure 2-10: The x-, y-, and z-axes and the related xy-, xz-, and yz-planes

[image: f0210.eps]


The point where the scales intersect is called the origin. For each axis, all values on one side of the origin are positive, all values on the other side are negative, and values that fall in line with the origin have a value of 0 (zero). The divisions along the scales may be any size, but each division must be equal. The axes divide the coordinate system into four regions called quadrants. Quadrant I is the region above the x-axis and to the right of the y-axis. Quadrant II is the region above the x-axis and to the left of the y-axis. Quadrant III is the region below the x-axis and to the left of the y-axis. Quadrant IV is the region below the x-axis and to the right of the y-axis. Most of your work in AutoCAD will be done in Quadrant I, and this is the area shown when you first open a drawing.

Any point on a graph can be specified by giving its coordinates relative to the origin given as a combination of the X value and the Y value delineated with a comma. For example, a coordinate of 5,7 means a point on the coordinate system that is 5 units in the positive X direction and 7 units is the positive Y direction. Figure 2-11 shows a typical Cartesian Coordinate System and the default region used as the drawing area in a new AutoCAD file.


[image: note.tif]
NOTE AutoCAD displays a readout for the z-coordinate as well, but you can ignore it for now because you’ll be working in only two dimensions for the majority of this book. The z-coordinate always reads 0 until you work in three dimensions. (This will be covered in the later chapters.) AutoCAD LT doesn’t have the readout for the z-coordinate because it doesn’t have 3D capabilities.




Figure 2-11: The x- and y-coordinates of the drawing area
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In this next exercise, you’ll try using the LINE command again, but instead of picking points in the drawing area with the mouse as you did before, this time enter the x- and y-coordinates for each point from the keyboard. To see how to do this, follow these steps:


You can also start the ERASE command by entering E↵.



[image: m0205.tif]

1. Click the Erase button from the Home  Modify Ribbon panel,

2. Enter ALL↵. The objects in the drawing become dashed to indicate that they are selected.

3. Press ↵ to clear the screen.
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4. Click the Dynamic Input button in the command line to turn off this feature. The button will change to a gray background.



Now begin drawing lines again by following these steps:


1. Start the LINE command by clicking the Line button from the Home tab  Draw panel on the Ribbon.

2. Enter 7,2↵ to start the first line segment at a location 7 units above and 2 units to the right of the drawing’s origin point.

3. Enter 11,3↵ to determine the endpoint of the line.

4. Enter 9,6↵.

5. Enter 7,2↵.

6. Enter 1,4↵.

7. Enter 3,7↵.

8. Enter 9,6↵.

9. Press ↵ again to end the command.



Figure 2-12 shows the completed drawing, with coordinates and direction arrows added for clarity.


Figure 2-12: Completed drawing showing coordinates and direction of lines
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The lines are similar to those you drew previously, but this time you know where each point is located relative to the 0,0 point. In the drawing area, every point has an absolute x- and y-coordinate. In steps 2 through 8, you entered the x- and y-coordinates for each point. For a new drawing such as this one, the origin (0,0 coordinate) is in the lower-left corner of the drawing area and all points in the drawing area have positive x- and y-coordinates.

Let’s explore how the cursor is related to the coordinates in the drawing.

[image: m0207.tif]

1. Click the Zoom Extents button located on the navigation bar (the semitransparent vertical bar under the ViewCube), or enter ZOOM↵ E↵ to adjust your view to show the extents of the drawing area.

2. Move the cursor around, and notice the left end of the status bar at the bottom of the screen. This is the coordinate readout, and it displays the coordinates of the cursor’s position, as shown in Figure 2-13.


Figure 2-13: The x- and y-coordinates of the cursor are shown at the bottom of the AutoCAD window.

[image: f0213.tif]


3. Move the cursor as close to the lower-left corner of the drawing area as you can without it changing into an arrow. The coordinate readout should be close to 0.0000,0.0000,0.0000.

4. Move the cursor to the top-left corner of the drawing area. The readout changes to something close to 0.0000,7.0000,0.0000, indicating that the top of the screen is 7 units from the bottom.

5. Move the cursor one more time to the upper-right corner of the drawing area. The readout still has a y-coordinate of approximately 7.0000. The x-coordinate now has a value around 10.5.



The drawing area of a new drawing is preset with the lower-left corner of the drawing at the coordinates 0,0.


[image: note.tif]
NOTE For the moment, it doesn’t matter what measure of distance these units represent. I’ll address that topic in Chapter 3, “Setting Up a Drawing.” Don’t worry about the four decimal places in the coordinate readout; the number of places is controlled by a setting you’ll learn about soon.



Using Relative Coordinates

Once you understand the coordinate system used by AutoCAD, you can draw lines to any length and in any direction. Look at the shape shown earlier in Figure 2-1. Because you know the dimensions, you can calculate, by adding and subtracting, the absolute coordinates for each vertex — the connecting point between two line segments — and then use the LINE command to draw the shape by entering these coordinates from the keyboard. However, AutoCAD offers you several tools for drawing this box much more easily. Two of these tools are the Relative Cartesian and the Relative Polar Coordinate Systems.

When you’re drawing lines, these coordinate systems use a set of new points based on the last point designated, rather than on the 0,0 point of the drawing area. They’re called relative systems because the coordinates used are relative to the last point specified. If the first point of a line is located at the coordinate 4,6 and you want the line to extend 8 units to the right, the coordinate that is relative to the first point is 8,0 (8 units in the positive X direction and 0 units in the positive Y direction), whereas the actual — or absolute — coordinate of the second point is 12,6.

The Relative Cartesian Coordinate System uses relative x- and y-coordinates in the manner shown, and the Relative Polar Coordinate System relies on a distance and an angle relative to the last point specified. You’ll probably favor one system over the other, but you need to know both systems because you’ll sometimes find that, given the information you have at hand, one will work better than the other. A limitation of this nature will be illustrated in Chapter 4, “Developing Drawing Strategies: Part 1.”

When the Dynamic Input tool is turned off, you’ll need to prefix the coordinate with an “at” symbol (@). In the previous example, you would enter the relative Cartesian coordinates as @8,0. The @ lets AutoCAD know that the numbers following it represent coordinates that are relative to the last point designated. When the Dynamic Input tool is turned on, relative coordinates are assumed, and the @ symbol is not required.

Relative Cartesian Coordinates

The Cartesian system of coordinates uses a horizontal (x) component and a vertical (y) component to locate a point relative to the 0,0 point. The relative Cartesian system uses the same components to locate the point relative to the last point picked, so it’s a way of telling AutoCAD how far left or right and up or down to extend a line or to move an object from the last point picked (see Figure 2-14). If the direction is to the left, the x-coordinate will be negative. Similarly, if the direction is down, the y-coordinate will be negative. Use this system when you know the horizontal and vertical distances from point 1 to point 2. To enter data using this system, use this form: @x,y.


Figure 2-14: The Relative Cartesian Coordinate System
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Relative Polar Coordinates

This system requires a known distance and direction from one point to the next. Calculating the distance is straightforward: it’s always positive and represents the distance away from the first point that the second point will be placed. The direction requires a convention for determining an angle. AutoCAD defines right (toward three o’clock) as the default direction of the 0° angle. All other directions are determined from a counterclockwise rotation (see Figure 2-15). On your screen, up is 90°, left is 180°, down is 270°, and a full circle is 360°. To let AutoCAD know that you’re entering an angle and not a relative y-coordinate, use the less-than symbol (<) before the angle and after the distance. Therefore, in the previous example, to designate a point 8 units to the right of the first point, you would enter @8<0 or simply 8<0 when the Dynamic Input tool is active.


[image: note.tif]
NOTE Use the Relative Polar Coordinates method to draw a line from the first point when you know the distance and direction to its next point. Enter data using this form: @distance<angle.



Using the Direct Distance Method

You can also draw lines by placing the cursor at any angle relative to the last point and entering a distance value at the command prompt. The line is drawn from the last point toward or through the cursor location at the length specified. The Direct Distance method is often used when either Ortho mode or Polar Tracking is turned on.


Figure 2-15: The Relative Polar Coordinate System
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NOTE When in a drawing command, Ortho mode restricts the cursor to horizontal or vertical movements. Lines, for example, can only be drawn at 0°, 90°, 180°, and 270°. Ortho mode is toggled on using the Ortho Mode button at the bottom of the user interface (UI) or by pressing the F8 key.



Drawing the Shape

Now that you have the basics, the following exercises will take you through the steps to draw the four lines that form the outline of the shape using both relative coordinate systems.

Using Relative Cartesian Coordinates

To begin drawing the box, use the same drawing:


1. If your drawing is already blank, jump to step 2. If you still have lines on your drawing, start the ERASE command, enter ALL↵, and then press ↵ again to delete them.

2. Start the LINE command by selecting Home tab  Draw panel  Line.

3. At the Specify first point: prompt in the command window, enter 3,3↵. This is an absolute Cartesian coordinate and will be the first point.

4. Enter @6,0↵.

5. Enter @0,5↵.
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6. Turn on the Dynamic Input tool in the status bar and, if necessary, scroll the mouse wheel to zoom out to see the extents of the lines.

7. Enter -6,0↵. Notice that since Dynamic Input is turned on, the @ symbol is no longer required to input relative coordinates.

8. Look at the command prompt. It reads: Specify next point or[Close/Undo]:. Items enclosed in brackets are additional available options at that particular point of the command that can be entered at the command prompt. Only the capitalized letters are required to execute an option.

9. Enter C↵ to execute the Close option. Entering this letter after drawing two or more lines closes the shape by extending the next line segment from the last point specified to the first point (see Figure 2-16). It also ends the LINE command. Notice that in the command window the prompt is Command:. This signifies that AutoCAD is ready for a new command.




Figure 2-16: The first four lines of the box
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Erasing Lines

To prepare to draw the box again, use the ERASE command to erase the four lines you just drew:

[image: m0209.tif]

1. Start the ERASE command by choosing Home tab  Modify panel  Erase tool. Notice how the cursor changes from the crosshair to a little square. This is called the pickbox. When you see it on the screen, it’s a sign that AutoCAD is ready for you to select objects on the screen. Also notice the command window; it’s prompting you to select objects.

2. Place the pickbox on one of the lines, and click it when it highlights. The line changes to a dashed line to indicate that it is selected.


[image: g0201.tif]


3. Repeat step 2 for the remaining lines.

4. Press ↵. The objects are erased, and the ERASE command ends.




[image: note.tif]
NOTE You’ve been introduced to two methods of selecting lines to be erased: typing ALL↵ and using the pickbox to select them. Throughout the book, you’ll learn other ways to select objects. The selection process is important in AutoCAD because you need to be able to select objects quickly and precisely.



Controlling How the Selection Tools Are Displayed

When you move the cursor over an object, AutoCAD highlights the object. This is called rollover highlighting. It tells you that clicking while the object is highlighted selects that object. You have some choices as to how this highlighting appears:


1. In the Application menu, click the Options button at the bottom (Application Menu  Options) to open the Options dialog box.

2. Click the Selection tab. Notice the Selection preview area in the middle of the left side (see Figure 2-17, right). Here you can activate or deactivate the check boxes to control whether rollover highlighting occurs when a command is running or when no command is running. If both check boxes are checked, the feature works all the time.


Feel free to experiment with these settings until you find a combination that works for you.



3. Click the Visual Effect Settings button below the check boxes to open the Visual Effect Settings dialog box (see Figure 2-17, bottom). There are two areas: Selection Preview Effect and Area Selection Effect. The Selection Preview Effect area controls how the rollover highlighting feature is displayed. Lines can dash, lines can thicken, and lines can both dash and thicken, depending on which radio button is selected.

4. Make any changes you want, and then click OK. Back in the Options dialog box, click OK to return to your drawing.




Figure 2-17: The Selection Preview area of the Selection tab in the Options dialog box (left) and the Visual Effect Settings dialog box (right)
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Using Relative Polar Coordinates

Now draw the shape again using the Relative Polar method by following these steps:


1. Start the LINE command by selecting Home tab  Draw panel  Line tool.

2. Enter 3,3↵ to start the box at the same point.

3. Enter 6<0↵. Because the Dynamic Input tool is turned on, the @ symbol is not required.

4. Enter 5<90↵.

5. Enter 6<180↵.

6. Enter C↵ to close the box and end the LINE command. Your box once again resembles the box shown earlier in Figure 2-16.



You can see from this exercise that you can use either method to draw a simple shape. When the shapes you’re drawing become more complex and the amount of available information about the shapes varies from segment to segment, one of the two relative coordinate systems will turn out to be more appropriate. As you start drawing the floor plan of the cabin in Chapters 3 and 4, you’ll get more practice using these systems.

Using Direct Input

Now draw the box once more, this time using the Direct Input method by following these steps:


1. Erase the lines in your drawing as you did in a prior exercise (Home tab  Modify panel  Erase tool).
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2. Make sure Polar Tracking is turned on; then start the LINE command.

3. Enter 3,3↵ to start the box at the same point.

4. Place the cursor so that it is directly to the right of the first point. When the cursor is nearly perpendicular, it will snap to a perfectly horizontal orientation. The Dynamic Input field shows a value of 0º and the distance from the first point, as shown in Figure 2-18.


Figure 2-18: Drawing a line using the Direct Input method
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5. Enter 6↵. The first line is created extending from the initial point to a point 6 units away at an angle of 0º. Notice that the @ symbol is not required when using direct input.

6. Move the cursor so that it is directly above the last point until the angle field reads 90º; then enter 5↵. A vertical line 5 units long is drawn from the previous point.

7. Move the cursor so that it is directly to the left of the end of the last line drawn and then enter 6↵. A horizontal line 6 units long is drawn from the previous point. Even though the line is drawn in the negative X direction, the minus sign (negative indicator) is not required. Because Dynamic Input was turned on, the minus sign was implied based on the location of your cursor. In other words, AutoCAD drew the line in the direction your cursor was located.

8. Enter C↵ to close the box and end the LINE command. Your box once again resembles the box shown in Figure 2-16 earlier.



You can see from these exercises that you can use multiple methods to draw a simple shape. Showing so many methods may seem a little redundant at this point; however, as the shapes you draw become more complex and the amount of available information about the shapes varies from segment to segment, you’ll likely begin choosing one method or another based on the information available to you. As you start drawing the floor plan of the cabin in Chapters 3 and 4, you’ll get more practice applying these methods to more realistic scenarios, and you’ll probably begin establishing the methods that work best for you.

Some additional tools make the process of drawing simple, orthogonal lines like these much easier. I’ll introduce these tools in the following three chapters.

Using the Offset Command

The next task is to create the lines that represent the inside walls of the box. Because they’re all equidistant from the lines you’ve already drawn, the OFFSET command is the appropriate command to use. You’ll offset the existing lines 0.5 units to the inside.

The OFFSET command involves three steps:


1. Setting the offset distance (Specify offset distance).

2. Selecting the object to offset (Select object to offset).

3. Indicating the offset direction (Specify point on side to offset).



Here’s how it works:
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1. Be sure the prompt line in the command window reads Command:. If it doesn’t, press the Esc key until it does. Then launch the OFFSET command by choosing the Home tab  Modify panel  Offset tool. The prompt changes to Specify offset distance or[Through/Erase/Layer]<Through>:. This is a confusing prompt, but it will become clear soon. For now, let’s specify an offset distance through the keyboard.


You can also start the OFFSET command by typing O↵.




[image: warning.tif]
WARNING As important as it is to keep an eye on the command window, some prompts may not make sense to you until you get used to them. When using the Dynamic Input option, notice that the command prompt also appears at the cursor.



2. Enter 0.5↵ for a distance to offset the lines ½ unit. Now you move to the second stage of the command. Note that the cursor changes to a pickbox, and the prompt changes to Select object to offset or[Exit/Undo]<Exit>:.

3. Place the pickbox on one of the lines, and click it when it highlights. The selected line appears dashed to indicate that it is selected (see Figure 2-19), the cursor changes back to the crosshair, and the prompt changes to Specify point on side to offset or[Exit/Multiple/Undo]<Exit>:. AutoCAD is telling you that to determine the direction of the offset, you must specify a point on one side of the line or the other. You make the choice by selecting anywhere in the drawing area on the side of the line where you want the offset to occur.


    Figure 2-19: From left to right, the series of prompts required to execute the OFFSET command: distance, object, and direction
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    4. Click a point somewhere inside the box (you don’t have to be precise, just so long as you select a point inside the box). The offset takes place, and the new line is exactly 0.5 units to the inside of the chosen line (see Figure 2-20). Notice that the pickbox comes back on. The OFFSET command is still running, and you can offset more lines by the same distance.

You have three more lines to offset.

5. Click another line; then click inside the box again. The second line is offset.

6. Click a third line, click inside the box; click the fourth line, and then click again inside the box (see Figure 2-21).

7. Press ↵ to end the OFFSET command.




Figure 2-20: The first line is offset.

[image: f0220.tif]



Figure 2-21: Four lines have been offset.

[image: f0221.tif]



You can cancel a command at any time by pressing Esc or by right-clicking and choosing Cancel from the context menu.




[image: note.tif]
NOTE The offset distance stays set at the last distance you specify — 0.5, in this case — until you change it.



This command is similar to the LINE command in that it keeps running until it’s stopped. With OFFSET, after the first offset, the prompts switch between Select object to offset or[Exit/Undo]<Exit>: and Specify point on side to offset or[Exit/Multiple/Undo]<Exit>: until you press ↵ or the spacebar to end the command.

The inside lines are now drawn, but to complete the box, you need to clean up the intersecting corners. To handle this task efficiently, you’ll use a tool called the FILLET command.


Specifying Distances for the OFFSET Command

The prompt you see in the command window after starting the OFFSET command is


Specify offset distance or[Through/Erase/Layer]<Through>:



This prompt describes several options for setting the offset distance:


	Enter a distance from the keyboard.

	Select two points on the screen to establish the offset distance as the distance between those two points.

	Press ↵ to accept the offset distance or option that is displayed in the prompt in the angle brackets.

	Enter T↵ to use the Through option. When you select this option, you’re prompted to select the line to offset. You’re then prompted to pick a point. The line will be offset to that point. When you pick the next line to offset, you then pick a new point to locate the position of the new line. The Through option allows each line to be offset a different distance.

	Enter E↵, and then enter Y↵ to tell AutoCAD to erase the original line that was offset. (After doing this, however, AutoCAD continues erasing offset lines until you reset it by typing E↵ N↵ at the beginning of the OFFSET command.)

	Enter L↵ to use the Layer option. (I’ll discuss this option in Chapter 6, “Using Layers to Organize Your Drawing.”)



As you become accustomed to using OFFSET, you’ll find uses for each of these options.



Using the Fillet Command

The FILLET command lets you round off a corner formed by two lines. You control the radius of the curve, so if you set the curve’s radius to zero, the lines form a sharp corner (without a curve/arc). Thanks to this behavior of the FILLET command, it is commonly used to clean up corners such as the ones formed by the lines inside the box. You must pick points on the filleted lines on portions that will remain after the fillet is implemented; otherwise, the wrong portion of the line may be retained. Figure 2-22 illustrates how to use the FILLET command to achieve the desired result.


Figure 2-22: Selecting objects to obtain the expected result when using the FILLET command

[image: f0222.eps]
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1. When the command line just reads Command:, launch the FILLET command by choosing the Home tab  Modify panel  Fillet tool. Notice how the command window changes after you’ve clicked the Fillet button (see Figure 2-23).


Figure 2-23: The command prompt after initiating the FILLET command

[image: f0223.tif]



You can also start the FILLET command by entering F↵.



The default Fillet radius should be 0.0000 units. Like the Offset distance, the Fillet radius remains set at a constant value until you change it.

2. If your command window displays a radius of 0.0000, go on to step 3. Otherwise, enter R↵, and then enter 0↵ to change the radius to zero.


The down-pointing arrow next to the Fillet tool opens a fly-out menu that includes the Chamfer tool.




[image: tip.tif]
TIP When the radius value is set higher than 0, you can temporarily override this by holding the Shift key down while picking the two objects to be filleted. They will be filleted with a radius of 0, while the value set in the FILLET command remains unchanged.



3. Move the cursor — now a pickbox — to the shape, and click two intersecting lines, as shown in Figure 2-24. The intersecting lines are both trimmed to make a sharp corner (see Figure 2-25). The FILLET command automatically ends.


Figure 2-24: Pick two lines to execute the FILLET command.

[image: f0224.eps]



Figure 2-25: The first cleaned-up corner

[image: f0225.tif]


4. Press ↵ to restart the command, and this time enter M↵ to activate the Multiple option. Multiple repeats the FILLET command until another option is initiated at the command prompt or the command is terminated with the Enter or Esc keys or the spacebar.

5. Fillet the lower-left and lower-right crossing lines to clean up those corners (see Figure 2-26) and press ↵.


Figure 2-26: The box with three corners cleaned up

[image: f0226.tif]



Once a command has ended, you can restart it by pressing either ↵ or the spacebar or by right-clicking and choosing Repeat from the context menu.




[image: tip.tif]
TIP In most cases, you’ll get the same effect by pressing the spacebar as you get by pressing ↵. The exception is when you’re entering data in a text box in a dialog box or a palette; in those cases, pressing the spacebar inserts a space.



6. Press ↵ to restart the FILLET command. This time, enter R↵ 0.5↵ to set the fillet radius to 0.5, and then click the two lines that make up the interior upper-right corner.

7. Restart the command, set the radius to 1.0, and then fillet the outer upper-right corner. Your box should look like Figure 2-27.




Figure 2-27: The box with the curved radii in the upper-right corner
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NOTE If you make a mistake and pick the wrong part of a line or the wrong line, press Esc to end the command and then enter u↵. This will undo the effect of the last command.



Used together like this, the OFFSET and FILLET commands are a powerful combination of tools for laying out walls on a floor plan drawing. Because these commands are so important, let’s take a closer look at them to see how they work. Both commands are in the Modify panel of the Ribbon and in the Modify menu of the menu bar, both have the option to enter a numeric value or accept the current value — for offset distance and fillet radius — and both hold that value as the default until it’s changed. However, the OFFSET command keeps running until you stop it, and the FILLET command stops after each use unless the Multiple option is invoked. These commands are two of the most frequently used tools in AutoCAD. You’ll learn about more of their uses in later chapters.

The FILLET command has a sister command, CHAMFER, which is used to bevel corners with straight lines. When the distances for the CHAMFER command are set to 0, you can use the command to clean up corners the same way that you use the FILLET command. Some users prefer to use CHAMFER rather than FILLET because they don’t bevel corners, but they may at times use FILLET to round off corners. If you use CHAMFER to clean up corners, FILLET can have any radius and won’t have to be overridden or reset constantly to 0. You’ll develop your own preference.

Completing the Shape

The final step in completing the box (Figure 2-1 from the beginning of this chapter) is to make an opening in the bottom wall. From the diagram, you can see that the opening is 2 units wide and set off from the right inside corner by 0.5 units. To make this opening, you’ll use the OFFSET command twice, changing the offset distance for each offset, to create marks for the opening.

Offsetting Lines to Mark an Opening

Follow these steps to establish the precise position of the opening:


1. At the command prompt, start the OFFSET command (Home tab  Modify panel  Offset tool). Notice the command window. The default distance is now set at 0.5, the offset distance you previously set to offset the outside lines of the box to make the inside lines. If the distance is different, enter 0.5↵. You’ll want to use this distance again. Press ↵ to accept this preset distance.

2. Pick a point inside the vertical line on the right, and then pick a point to the left of this line. The line is offset, creating a new line 0.5 units to the left (see Figure 2-28).


Figure 2-28: Offsetting the first line of the opening
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3. Press ↵ to end the OFFSET command, and then press it again to restart the command. This will allow you to reset the offset distance.

4. Enter 2 as the new offset distance, and press ↵.

5. Click the new line, and then pick a point to the left. Press ↵ to end the Offset command (see Figure 2-29).




Figure 2-29: Offsetting the second line of the opening
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You now have two new lines indicating where the opening will be. You can use these lines to form the opening using the EXTEND and TRIM commands.


[image: tip.tif]
TIP The buttons you’ve been clicking in this chapter are also referred to as icons and tools. When they’re in dialog boxes or on the status bar, they have icons (little pictures) on them and look like buttons to push. When they’re on the Ribbon or toolbars, they look like icons. But when you move the pointer arrow cursor onto one, it takes on the appearance of a button with an icon on it. I’ll use all three terms — button, icon, and tool — interchangeably throughout this book.



Extending Lines

The EXTEND command is used to lengthen (extend) lines to meet other lines or geometric figures (called boundary edges). Executing the EXTEND command may be a little tricky at first until you see how it works. Once you understand it, however, it will become automatic. The command has two steps: first, you pick the boundary edge or edges; second, you pick the lines you want to extend to meet those boundary edges. After selecting the boundary edges, you must press ↵ before you begin selecting lines to extend.

[image: m0213.tif]

1. Launch the EXTEND command by selecting the Home tab  Modify panel  Extend tool. If you don’t see it, click the down arrow next to the Trim icon and then choose Extend from the fly-out menu. 

2. Notice in the command window that the bottom line says Select objects or<select all>:, but in this case you need to observe the bottom two lines of text in order to know that AutoCAD is prompting you to select boundary edges (see Figure 2-30).


Figure 2-30: The command window while using the EXTEND command
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You can also start the EXTEND command by entering EX↵.



3. Pick the very bottom horizontal line (see Figure 2-31), and press ↵.


[image: tip.tif]
TIP The Select Objects: prompt would be more useful if it said “Select objects and press Enter when finished selecting objects.” But it doesn’t. You have to train yourself to press ↵ when you finish selecting objects in order to get out of Selection mode and move on to the next step in the command.




Figure 2-31: Selecting a line to be a boundary edge

[image: f0231.tif]


4. Pick the two new vertical lines created by the OFFSET command. Be sure to place the pickbox somewhere on the lower halves of these lines or AutoCAD will attempt to extend the opposite ends of the lines. Because there are no boundary edges that could intersect with extensions from the top end of the lines, AutoCAD will apparently ignore your picks if you select the wrong ends. The lines are extended to the boundary edge line.

5. Press ↵ to end the EXTEND command (see Figure 2-32).




Figure 2-32: The lines are extended to the boundary edge.
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Trimming Lines

The final step is to trim away the horizontal lines to complete the opening and the unneeded portions of the two most recent vertical lines that you offset. To do this, you use the TRIM command. Like the EXTEND command, TRIM has two steps. The first is to select reference lines. In this case, they’re called cutting edges because they determine the edge or edges to which a line is trimmed. The second step is to pick the lines that are to be trimmed. Also like the EXTEND command, TRIM lets you select the objects individually, or using one of the many other object selection methods found inside AutoCAD. In this lesson you’ll have a chance to try out one of these methods, known as the Fence method.

[image: m0214.tif]

1. Choose the Home tab  Modify panel, click the down arrow next to the Extend button, and then choose Trim from the fly-out menu. This will launch the TRIM command. Notice the command window. Similar to the EXTEND command, the bottom line prompts you to select objects or select everything in the drawing, but the second line up tells you to select cutting edges.


You can also start the Trim command by entering TR↵.



2. Pick the two vertical offset lines that were just extended as your cutting edges, and then press ↵ (see Figure 2-33).

3. Notice that the command line reads Select object to trim or shift-select to extend or[Fence/Crossing/Project/Edge/eRase/Undo]:.Enter F to start the Fence mode.


Figure 2-33: Lines selected to be cutting edges

[image: f0233.eps]


4. Your command line now reads Specify first fence point:. Using the Fence method, you will draw an imaginary line through the objects you want to trim. Use your cursor to draw a line that crossesthe two horizontal lines across the opening somewhere between the cutting edge lines (see Figure 2-34).




Figure 2-34: Lines selected to be trimmed
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NOTE Note that in these trimming procedures, the endpoints of the cutting edge lines, as well as the lines themselves, are used as cutting edges.



The opening is trimmed away (see Figure 2-35).


Figure 2-35: Lines are trimmed to make the opening.
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NOTE If you trim the wrong line, or the wrong part of a line, you can click the Undo button on the Quick Access toolbar on the left side of the AutoCAD title bar. This undoes the last trim without canceling the TRIM command, and you can try again.



Now let’s remove the extra part of the trimming guidelines.


1. Press ↵ twice — once to end the TRIM command and again to restart it. The command line asks you to Select objects or<select all>.

2. Instead of selecting your cutting edges manually, you can press ↵ once again. Doing this will accept the default “<select all>” option listed at the command line. Using this method, every object in your drawing will be treated as a cutting edge. 

3. Pick the two vertical lines that extend above the new opening. Be sure to pick them above the opening (see Figure 2-36). The lines are trimmed away, and the opening is complete. Press ↵ to end the TRIM command (see Figure 2-37).




Figure 2-36: Lines picked to be trimmed

[image: f0236.eps]


Congratulations! You’ve just completed the first drawing project in this book and you’ve covered all the tools in this chapter. These skills will be useful as you learn how to work on drawings for actual projects.


Figure 2-37: The completed trim
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NOTE You can check your finished shape by comparing it to Chapter02More Practice Completed.dwg, which is available from the book’s website at www.sybex.com/go/autocad2011ner.



A valuable exercise at this time would be to draw this box two or three more times, until you can do it without the instructions. This will be a confidence-builder to get you ready to take on new information in the next chapter, in which you’ll set up a drawing for a building.

The box you drew was 6 units by 5 units, but how big was it? You really don’t know at this time because the units could represent any actual distance: inches, feet, meters, miles, and so on. Also, the box was positioned conveniently on the screen so you didn’t have any problem viewing it. What if you were drawing a building that was 200′ (60.96 meters) long and 60′ (18.29 meters) wide or a portion of a microchip circuit that was only a few thousandths of an inch or millimeters long? In the next chapter, you’ll learn how to set up a drawing for a project of a specific size.

A completed version of this exercise can be found in this book’s web page, www.sybex.com/go/autocad2011ner, as Chapter02Shape Completed.dwg.

You can save the file by clicking the Save button on the Quick Access toolbar or exit AutoCAD now without saving this drawing. To do the latter, expand the Application menu, and then click the Exit AutoCAD button in the lower-right corner. When the dialog box asks if you want to save changes, click No. Alternatively, you can leave AutoCAD open and go on to the following practice section or the next chapter.

If You Would Like More Practice…

Draw the object shown in Figure 2-38.


Figure 2-38: Practice drawing
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You can use the same tools and strategy used to draw the shape. Choose New from the Application menu (Application Menu  New  Drawing) to start a new drawing, and then use the acad.dwt template file. Here’s a summary of the steps to follow:


1. Ignore the three openings at first.

2. Draw the outside edge of the shape using one of the relative coordinate systems. To make sure the shape fits on your screen, start the outline of the box in the lower-left corner at the absolute coordinate of 1,0.5.

3. Offset the outside lines to create the inside wall.

4. Fillet the corners to clean them up. (Lines that aren’t touching can be filleted just like lines that intersect.)

5. Use the OFFSET, EXTEND, and TRIM commands to create the three openings.



Feel free to check your work against Chapter02More Practice Completed.dwg on this book’s web page. Don’t worry about trying to put in the dimensions, center line, or hatch lines. You’ll learn how to create those objects later in the book.

Are You Experienced??

Now you can…


	understand the basics of coordinates

	distinguish between absolute and the two relative coordinate systems used by AutoCAD

	input coordinates using the Direct Input method

	use the LINE, ERASE, OFFSET, FILLET, EXTEND, and TRIM commands to create a drawing







Chapter 3: Setting Up a Drawing

In Chapter 2, “Learning Basic Commands to Get Started,” we explored the default drawing area that is set up when you open AutoCAD and start a new drawing. Using an assortment of common commands, you drew a box within the drawing area. If you drew the additional diagram offered as a supplemental exercise, the drawing area was set up the same way.

From this point forward, I’ll provide the metric equivalents in parentheses for readers who do not work in Imperial units, the standard for architectural design in the United States. Throughout the majority of this book, you’ll be developing drawings for a cabin with outside wall dimensions of 28′×18′ (8550mm5490mm). Whether or not you work in architecture, the tools you’ll use and the skills you’ll learn in this exercise will translate into nearly any discipline, enabling you to draw objects of any shape or size. In this chapter, you’ll learn how to set up the drawing area to lay out the floor plan for a building of a specific size. The Decimal units with which you have been drawing until now will be changed to feet and inches, and the drawing area will be transformed so that it can represent an area large enough to display the floor plan of the cabin you’ll be drawing.

As you learn to set up your drawing, you’ll also begin exploring ways to navigate your drawing more easily, draw lines at a specified incremental distance (such as the nearest foot), and more. Finally, you’ll save this drawing to a special folder on your hard drive. At the end of the chapter is a general summary of the various kinds of units that AutoCAD supports.


	Setting up drawing units

	Using AutoCAD’s grid

	Zooming in and out of a drawing

	Naming and saving a file



Setting Up the Drawing Units

When you draw lines of a precise length in AutoCAD, you use one of five kinds of linear units. Angular units can also be any of five types. The combination you choose will largely depend on the type of drawings you plan to prepare. We’ll discuss each of these linear and angular units at the end of this chapter, but for now let’s focus on getting ready to begin drawing our cabin.

When you first start a new drawing, AutoCAD displays a blank drawing called Drawing#.dwg. By default the linear and angular units inside this drawing are set to decimal numbers. The units and other basic setup parameters applied to this new drawing are based on a prototype drawing with default settings — including those for the units. This chapter covers some of the tools for changing the basic parameters of a new drawing so that you can tailor it to the cabin project or for your own project. Begin by setting up new units:

[image: m0301.tif]

1. With AutoCAD running, close all drawings and then click the New button (on the Quick Access toolbar) to start a new drawing. In the Select Template dialog box, click the arrow to the right of the Open button and select Open With No Template – Imperial (see Figure 3-1) or Open With No Template – Metric, depending on your preference.


Figure 3-1: The Select Template dialog box

[image: f0301.tif]



If the Select Template dialog box doesn’t appear after you click New from the Quick Access toolbar, use the Application Menu  New  Drawing.



[image: m0302.tif][image: m0303.tif]
To get started with the steps in this chapter, check to be sure each of the status bar buttons except Dynamic Input are clicked to the off position — that is, they appear unpushed and with a gray background. Also make sure you are in model space by clicking the Quick View Layouts Model view found on the status bar. When we get to later chapters, you’ll learn how to use the other tools, and in Chapter10, “Generating Elevations,” you’ll see how to use templates to set up drawings.

2. Choose Application Menu  Drawing Utilities  Units to open the Drawing Units dialog box (UNITS command) shown in Figure 3-2. In the Length area, Decimal is currently selected. Similarly, in the Angle area, Decimal Degrees is the default.


You can also open the Drawing Units dialog box by typing UN↵.



3. Within the Drawing Units dialog box, click the arrow in the Type drop-down list found inside the Length group, and select Architectural (metric users can leave this set to Decimal). These units are feet and inches, which you’ll use for the cabin project.

Notice the two Precision drop-down lists at the bottom of the Length and Angle areas. When you changed the linear unit specification from Decimal to Architectural, the number in the Precision drop-down list on the left changed from 0.0000 to 0′-0 1⁄16″. At this level of precision, linear distances are displayed to the nearest 1⁄16″. Metric users should set this to 0 because we won’t be using units smaller than a millimeter.


Figure 3-2: The Drawing Units dialog box

[image: f0302.tif]


4. Select some of the other Length unit types from the list, and notice the way the units appear in the Sample Output area at the bottom of the dialog box. Then select Architectural again or leave it set to Decimal for metric use.


[image: note.tif]
NOTE Drop-down lists are lists of options with only the selected choice displayed when the list is closed. When you click the arrow, the list opens. When you make another selection, the list closes and your new choice is displayed. When an item on the list is selected and is the focus of the program (indicated by a blue highlight), you can change the available options using the scroll wheel on a mouse or the up and down arrows on the keyboard. You can choose only one item at a time from the list.



5. Click the down arrow in the Precision drop-down list in the Length area to display the choices of precision for Architectural units (see Figure 3-3). This setting controls the degree of precision to which AutoCAD displays a linear distance. If it’s set to 1⁄16″, any line that is drawn more precisely — such as a line 6′-3 1⁄32″ long — when queried, displays a length value to the nearest 1⁄16″. or, in the example, as 6′-3 1⁄16″. However, the line is still 6′-3 1⁄32″ long.

If you change the precision setting to 1⁄32″ and then use the DISTANCE command to measure the distance between two features, you’ll see that its length is 6′-3 1⁄32″.

6. Click 0′-0 1⁄16″ to maintain the precision for display of linear units at 1⁄16″.




Figure 3-3: The Precision drop-down list for Architectural units (left) and Decimal units (right)

[image: f0303a.tif]
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If you open the Type drop-down list in the Angle area, you’ll see a choice, among others, between Decimal Degrees and Deg/Min/Sec. Like so many settings in AutoCAD, the correct setting here is often dictated by the type of drawings you’re preparing. Decimal angular units are the most popular choice for individuals working in architecture (or its related disciplines). On the other hand, Deg/Min/Sec and Surveyor’s units are each popular in civil engineering disciplines. 

Because our project is a cabin (architectural), we’ll use the default Decimal Degrees throughout this book; however, the default precision setting is to the nearest degree. This may not be accurate enough, so you should change it to the nearest hundredth of a degree:


1. Click the arrow in the Precision drop-down list in the Angle area.


[image: note.tif]
NOTE When using Metric units, 1 unit = 1 millimeter.



2. Select 0.00 as the precision value for angles. The Drawing Units dialog box will now indicate that, in your drawing, you plan to use Architectural length units with a precision of 1⁄16″ (Decimal with a precision of 0 if using metric) and Decimal angular units with a precision of 0.00º (see Figure 3-4). This doesn’t restrict the precision at which you draw, just the values that AutoCAD reports.

3. Change the Insertion Scale to Inches (Millimeters for metric). This often overlooked setting allows AutoCAD to automatically scale drawings to the proper size when inserted or referenced into other drawings.

This behavior is common as the architect has to collaborate with the civil engineer on a project. Architectural drawings are generally set up such that 1 unit is equal to 1 inch, whereas civil engineering drawings are set up such that 1 unit is equal to 1 foot. As these two collaborate, their drawings must be scaled up by 12 or down by 1⁄12, depending on whose drawing is being inserted. AutoCAD can automatically do this conversion for you, provided the Insertion Scale for your architectural drawings is set to Inches, and the civil engineering drawings to Feet.

Clicking the Direction button at the bottom of the Drawing Units dialog box opens the Direction Control dialog box, which has settings to control the direction of 0°. By default, 0° is to the right (east), and positive angular displacement goes in the counterclockwise direction. (See Figure 2-14 in Chapter 2 for an illustration of the Cartesian Coordinate System.) These are the standard settings for most users of CAD. There is no need to change them from the defaults. If you want to take a look, open the Direction Control dialog box, note the choices, and then click Cancel. You won’t have occasion in the course of this book to change any of those settings.


Figure 3-4: The Drawing Units dialog box after changes
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NOTE You’ll have a chance to work with the Surveyor’s angular units later in Chapter 12, “Dimensioning a Drawing,” when you develop a site plan for the cabin.



4. Click OK in the Drawing Units dialog box to accept the changes and close the dialog box. Notice the coordinate readout in the lower-left corner of the screen: it now reads in feet and inches.



This tour of the Drawing Units dialog box has introduced you to the choices you have for the types of units and the degree of precision for linear and angular measurement. The next step in setting up a drawing is to determine its size.


[image: note.tif]
NOTE If you accidentally click the mouse when the cursor is on a blank part of the drawing area, AutoCAD starts a rectangular window. I’ll talk about these windows soon, but for now just press the Esc key to close the window.



Setting Up the Drawing Size

Now that you have changed the units to Architectural, the drawing area is approximately 12″ to 16″ (500 mm) wide and 9″ (300 mm) high. You can check this by moving the crosshair cursor around on the drawing area and looking at the coordinate readout, as you did in the previous chapter.


[image: tip.tif]
TIP When you change Decimal units to Architectural units, one Decimal unit translates to one inch. Some industries, such as civil engineering, often use Decimal units to represent feet instead of inches. If the units in their drawings are switched to Architectural, a distance that was a foot now measures as an inch. To correct this, the entire drawing must be scaled up by a factor of 12.



The drawing area is defined as the part of the screen in which you draw. You can make the distance across the drawing area larger or smaller through a process known as zooming in or out. To see how this works, you’ll learn about a tool called the grid that helps you to draw and to visualize the size of your drawing.

The Grid

The AutoCAD grid is a pattern of horizontal and vertical gridlines that mimic the appearance of a sheet of graph paper, and is used as an aid to drawing. You can set the grid to be visible or invisible. The area covered by the grid depends on a setting called Drawing Limits, explained in the section “Setting Up Drawing Limits,” later in this chapter. To learn how to manipulate the grid size, you’ll make the grid visible, use the ZOOM IN and ZOOM OUT commands to vary the view of the grid, and then change the area over which the grid extends by resetting the drawing limits. 

Before doing this, however, let’s take a look at the icon that sits in the lower-left corner of the drawing area. This icon is known as the UCS or User Coordinate System icon. Some users consider the UCS icon to be a distraction when working in 2D, and choose to turn it off. Because the UCS icon does provide a relatively unobtrusive visual cue to how we’re looking at the drawing, this book will keep it turned on although it’s not necessary to have it turned on until Chapter 10 when we begin our discussion on 3D.


A diagonal arrow in the lower-right corner of a Ribbon panel (such as the one seen on the Coordinates panel) will take you to the settings for that group of tools.




1. From the View tab  Coordinates panel on the Ribbon, click the small arrow at the bottom-right corner of the Coordinates panel to open the UCS dialog box. If you pause the cursor over the arrow, you’ll see a tooltip that identifies the command that the button initiates, as shown in Figure 3-5.


Figure 3-5: Opening the UCS dialog box

[image: f0305.tif]


2. In the UCS Icon Settings area, verify the On option is checked, as shown in Figure 3-6, and then click OK. If you had wanted to turn the UCS icon off, you would have unchecked the On option, and the UCS icon would have disappeared until this setting was changed back to On.


You can also control the visibility of the UCS icon by entering UCSICON↵, followed by OFF↵, at the command prompt.



[image: m0304.tif]
3. Move the crosshair cursor to the status bar at the bottom of the screen, and click the Grid Display button. 

The button changes from the off to the on state (with a light blue background), and a series of horizontal and vertical lines appear in the drawing area, representing a piece of graph paper. 


Figure 3-6: Verifying the UCS icon visibility

[image: f0306.tif]


These lines are the grid. They are preset by default to be ½″ (10mm) apart, and they extend from the 0,0 point (the origin) out to the right and up to the coordinate point 1′-0″, 0′-9″ (490 mm, 290 mm). In the drawing area, the grid points may measure a greater distance apart, especially if you zoom out in the drawing. This is because, in the relatively large drawing area, lines spaced ½″ (10mm) apart would be very dense and working with them would be difficult. AutoCAD automatically reduces the density of the displayed grid lines to maintain a reasonable appearance in the drawing area.

4. To open the Drafting Settings dialog box, right-click on the Grid Display button and then choose Settings from the context menu that appears (see Figure 3-7).


Figure 3-7: Displaying the Drafting Settings dialog box

[image: f0307.tif]
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TIP Right-clicking any of the buttons (except Ortho Mode, Allow/Disallow Dynamic UCS, and Show/Hide Transparency) on the left side of the status bar and choosing Settings opens the Drafting Settings dialog box (or other appropriate dialog box for defining the tool’s parameters) to the tab with the parameters that relate to that specific button. You can also open the Drafting Settings dialog box by entering DS↵.



5. The Snap And Grid tab should be active (see Figure 3-8). If it’s not, click the tab. 

In the Grid Behavior area, be sure Adaptive Grid is checked and Display Grid Beyond Limits is unchecked. Then click OK. 

The grid now only covers the area from the origin to 12″,9″ (490mm, 290 mm), the area defined by the limits of the drawing, but extends to the extents of the drawing area. This will be evident after step 6.

Limits are discussed in the next section. The Adaptive Grid option causes AutoCAD to reduce the number of the grid’s columns and rows proportionately whenever the zoom factor would cause the grid to become too dense to be effective.

[image: m0305.tif]
6. To display a larger area within the drawing area, scroll the mouse wheel by dragging it toward you or use the Zoom Out command by clicking the drop-down arrow next to the Zoom tool from the View tab  Navigate panel on the Ribbon.


Figure 3-8: The Snap And Grid tab of the Drafting Settings dialog box

[image: f0308.tif]


The view changes and there are more grid lines in a denser configuration (see Figure 3-9). You may need to zoom twice to see the effect. Move the crosshair cursor to the lower-left corner of the grid, and then move it to the upper-right corner. Notice that the coordinate readout in the lower left of your screen now shows a large negative number for the lower-left corner and a larger positive number for the upper-right corner. You’re displaying a greater amount of space in the drawing area. A closer inspection of the grid will reveal one vertical line colored green and a horizontal line colored red. Where these lines intersect represents the origin, or 0,0 point inside your drawing. Any point above the red line and to the right of the green line will have a positive coordinate value.


Figure 3-9: The grid after zooming out

[image: f0309.tif]
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7. To the left of the Grid Display button on the status bar, click the Snap Mode button, and then move the cursor back onto the grid and look at the coordinate readout again. The cursor stops at each grid point intersection, even those that are no longer displayed due to the zoom factor, and the readout is to the nearest half inch. The Snap tool locks the cursor onto the grid lines; even when the cursor isn’t on the visible grid but somewhere outside it on the drawing area, the cursor maintains the grid spacing and jumps from one location to another.


Cursor Moving Erratically?

The Snap tool can be an incredibly powerful drawing aid when you intentionally turn it on. However, because the grid doesn’t have to be on to use Snap, many users accidentally enable the Snap tool and then report their cursor is moving erratically. If this happens to you at some point, remember to verify that your Snap is turned off to restore the “normal” fluid movement of the cursor.



8. Use the Zoom Out Command a few more times or scroll the mouse wheel.

[image: m0307.tif]
9. From the View tab  Navigate panel, choose Zoom  Zoom In or roll the scroll wheel on your mouse enough times to bring the view of the grid back to the way it appeared when it was first displayed. You aren’t changing the size of the grid, just the view of it. It’s like switching from a normal to a telephoto lens on a camera.



The grid is more of a guide than an actual boundary of your drawing. For most purposes, you can draw anywhere on the screen. The grid merely serves as a tool for visualizing how your drawing will be laid out.

Because it serves as a layout tool for this project, you need to increase the area covered by the grid from its present size to 60′×40′ (18 m12 m). 

Setting Up Drawing Limits

The Drawing Limits setting defines two properties in a drawing: it records the coordinates of the lower-left and upper-right corners of the grid and identifies what is displayed when the user executes a Zoom  All command with only a small portion of the drawing area in use. The coordinates for the lower-left corner are 0,0 by default and are usually left at that setting. You need to change only the coordinates for the upper-right corner and change the settings so that the grid is displayed only within the limits:


1. Make sure the command window displays the Command: prompt; then enter LIMITS↵. Notice how the command window has changed, as shown in Figure 3-10.


Figure 3-10: The command window after starting the LIMITS command

[image: f0310.tif]


The bottom command line tells you that the first step is to decide whether to change the default x- and y-coordinates for the lower-left limits, both of which are currently set at 0'-0",0'-0" (0,0). There is no need to change these.

2. Press ↵ to accept the 0'-0",0'-0" (0,0) coordinates for this corner. The bottom command line changes and now displays the coordinates for the upper-right corner of the limits. This is the setting you want to change.

3. Enter 60',40' (18000,12000)↵. Be sure to include the foot sign (').


[image: note.tif]
NOTE AutoCAD requires that, when using Architectural units, you always indicate that a distance is measured in feet by using the foot sign (′). You don’t have to use the inch sign (″) to indicate inches.
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4. To bring the entire area defined by the drawing limits onto the screen, use the ZOOM command again, but this time use the All option. From the View tab  Navigate panel, click the down arrow next to the Zoom tool and then click the All option, or enter Z↵ A↵. The All option zooms the view to display all the objects in the drawing or, in a blank drawing, zooms to the limits. The drawing area expands to display the drawing limits, and the grid changes appearance to accommodate the new view.

5. Right-click on the Grid Display button on the status bar and click Settings to open the Drafting Settings dialog box.

6. Uncheck the Display Grid Beyond Limits option and click OK. The grid no longer fills the screen, and there are blank areas on either side of the drawing area (see Figure 3-11).


Figure 3-11: The drawing with the grid extending to the 60′×40′ (18,000mm12,000mm) limits

[image: f0311.tif]


7. Move the cursor from one gridline to another and watch the coordinate readout. The coordinates are still displayed to the nearest half inch (10 mm), but the gridlines are much more than half an inch (10mm) apart.



By default, when you zoom in or out, AutoCAD adjusts the grid spacing to keep the gridlines from getting too close together or too far apart. In this case, remember that you found the grid spacing to be ½″ (10 mm) by default. If the drawing area is giving you a view of a 60′×40′ (18,000 mm12,000 mm) grid with gridlines at ½″ (10 mm), the grid has 1440 (1800) vertical gridlines and 960 (1200) horizontal gridlines. If the whole grid were to be shown on the screen, the gridlines would be so close together that they would be only about one pixel in size and would solidly fill the drawing area. So AutoCAD adjusts the spacing of the dots to keep the grid readable. You need to change that spacing to a more usable value.

For the drawing task ahead, it will be more useful to have the spacing set differently. Remember how you turned on Snap mode, and the cursor stopped at each gridline intersection? If you set the gridline spacing to 2′ (1000 mm) and the Snap Spacing to 6″ (50 mm), you can use Grid and Snap modes to help you draw the outline of the cabin, because the dimensions of the outside wall line are in whole feet (millimeters) and divisible by 2. The dimensions of the outside wall line are 28′×16′ (8550 mm4850 mm) and the exterior walls are 6″ (150mm) thick. Here’s how:


1. Right-click the Grid Display button on the status bar, and click Settings to open the Drafting Settings dialog box one more time. The Drafting Settings dialog box opens and the Snap And Grid tab is active. The settings in both the Grid and Snap areas include X and Y Spacing settings. Notice that they’re all set for a spacing of ½″ (10).

2. In the Grid Spacing area, click in the Grid X Spacing text box and change ½″ (10) to 2′ (1000) as shown in Figure 3-12. Then click in the Grid Y Spacing text box. It automatically changes to match the Grid X Spacing text box. If you want different Grid X and Grid Y Spacing values, you must uncheck the Equal X and Y Spacing option in the Snap Spacing area.

3. In the Snap section, change the Snap X Spacing setting to 6 (50) as shown in Figure 3-12. The inch sign isn’t required. Then click the Snap Y Spacing input box or press the Tab key. The Snap Y spacing automatically changes to match the Snap X Spacing setting.


If you set the Grid Spacing to 0, the grid takes on whatever spacing you set for the Snap X Spacing and Snap Y Spacing text boxes. This is how you lock the snap and grid together.



4. In the Snap Type area, be sure Grid Snap and Rectangular Snap are selected (Figure 3-12).

5. In the Grid Behavior area, only Adaptive Grid should be checked. With the grid set this way, AutoCAD will adjust the number of gridlines displayed as you zoom in and out, but it won’t add gridlines between the lowest grid spacing.


Figure 3-12: New settings on the Snap And Grid tab of the Drafting Settings dialog box using Imperial units (left) and Metric units (right)

[image: f0312a.tif]
[image: f0312b.tif]


6. The Snap On and Grid On check boxes at the top of the dialog box should be selected. If they aren’t, click them. Your Snap And Grid tab should look like Figure 3-12.

7. Click OK. The new 2′ (1000 mm) grid is now visible. Move the cursor around on the grid — be sure Snap is on. (Check the Snap Mode button on the status bar; it’s pressed when Snap is on.) Notice the coordinate readout. It’s displaying coordinates to the nearest 6″ (50mm) to conform to the new 6″ (50) snap spacing. The cursor stops at several snap points between each grid dot.

8. Move the crosshair cursor to the upper-right corner of the grid and check the coordinate readout. It should display 60′-0″, 40′-0″, 0′-0″ (18000.0000, 12000.0000, 0). (In AutoCAD LT, you won’t have the third coordinate.)



Drawing with Grid and Snap

Your drawing area now has the proper settings and is zoomed to a convenient magnification. You’re ready to draw the first lines of the cabin:


1. When the command window displays the Command: prompt, start the LINE command. From the Home tab  Draw panel, click the Line button or enter L↵. Enter 8',8'↵ (2500,2500↵), or move the cursor until the Dynamic Input fields indicate the cursor is over the 8',8' (2500,2500) point and then click to define the starting point of the line.

2. Hold the crosshair cursor above and to the right of the point you just picked. AutoCAD shows ghosted linear and angular dimensions that dynamically display the length and angle of the first line segment as the cursor moves, and a tooltip window displays the current prompt for the LINE command (see Figure 3-13).

3. Don’t click yet. Hold the crosshair cursor directly out to the right of the first point picked and note how the linear dimension displays a distance in 6″ (50 mm) increments. The angular dimension should have an angle of 0.00°, as shown in Figure 3-14.

4. Continue moving the crosshair cursor left or right until the dashed linear dimension displays 28′ (8550). At this point, click the left mouse button to draw the first line of the cabin wall (see Figure 3-15).

5. Move the crosshair cursor directly above the last point picked to a position such that the dashed linear dimension displays 18′ (5490) and the dashed angular dimension displays 90.00°, and then pick that point.


Figure 3-13: One point picked on the grid

[image: f0313.tif]



Figure 3-14: Setting the angle for the first line

[image: f0314.tif]



Figure 3-15: The first line of the cabin wall is drawn.

[image: f0315.tif]


6. Move the crosshair cursor directly left of the last point picked until the dashed linear dimension displays 28′ (8550) and the dashed angular dimension displays 180.00°, and then pick that point (see Figure 3-16).

7. Finally, enter C↵ to close the box. This tells AutoCAD to draw a line from the last point picked to the first point picked and, in effect, closes the box. AutoCAD then automatically ends the LINE command (see Figure 3-17).




Figure 3-16: Drawing the second and third wall lines

[image: f0316.tif]



Figure 3-17: The completed outside wall lines

[image: f0317.tif]


This method for laying out building lines by using Snap and Grid and the Dynamic Input is useful if the dimensions all conform to a convenient rounded-off number, such as the nearest six inches. The key advantage to this method over just typing the relative coordinates, as you did with the box in Chapter2,is that you avoid having to enter the numbers. You should, however, assess whether the layout you need to draw has characteristics that lend themselves to using Grid, Snap, and Dynamic Input or whether typing the relative coordinates would be more efficient. As you get more comfortable with AutoCAD, you’ll see that this sort of question comes up often: which way is the most efficient? This happy dilemma is inevitable in an application with enough tools to give you many strategic choices. In Chapters 4 and 5, “Developing Drawing Strategies: Parts 1 and 2,” you’ll learn other techniques for drawing rectangles.

A Closer Look at Dynamic Input

[image: m0309.tif]
The kind of information shown in dynamic display is similar to that shown in the command window, and the intent of this feature is to keep your eyes on the screen as much as possible. The specific information displayed depends, as it does on the command line, on what you’re doing at the time. It’s controlled by several settings that you access by right-clicking the Dynamic Input button on the status bar and selecting Settings from the context menu. This opens the Drafting Settings dialog box with the Dynamic Input tab activated (see Figure 3-18).


Figure 3-18: The Dynamic Input tab of the Drafting Settings dialog box

[image: f0318.tif]


This tab has three check boxes (two at the top and one near the middle on the right) and three buttons to open three feature-specific Settings dialog boxes. To make the dynamic input conform to what is shown in the book, do the following:


1. Make sure all three check boxes are selected.

2. In the Pointer Input area, click the Settings button to open the Pointer Input Settings dialog box (see Figure 3-19). In the Format area, the Polar Format and Relative Coordinates radio buttons should be selected. Click OK.

3. In the Dimension Input area, click the Settings button to open the Dimension Input Settings dialog box (see Figure 3-20).

4. Make sure the Show 2 Dimension Input Fields At A Time radio button is selected and then click OK.


Figure 3-19: The Pointer Input Settings dialog box

[image: f0319.tif]



Figure 3-20: The Dimension Input Settings dialog box

[image: f0320.tif]


5. Below the Dynamic Prompts area of the Drafting Settings dialog box, click the Drafting Tooltip Appearance button to open the Tooltip Appearance dialog box (see Figure 3-21). 

In the Apply To area at the bottom of the box, ensure that the Override OS Settings for All Drafting Tooltips radio button is selected. Vary the Colors, Size, and Transparency settings according to your preference. (I used a setting of 0 for Size and 0% for Transparency.) Don’t worry about Layout Color for now. The Model Color you choose depends on whether your drawing area has a light or dark background. Experiment. When you’re finished, click OK.

6. Click OK again to close the Drafting Settings dialog box.




Figure 3-21: The Tooltip Appearance dialog box

[image: f0321.tif]


If you decide to disable Dynamic Input, you can easily do so by clicking its button in the status bar so that it’s in unpushed mode (with a gray background).

Saving Your Work

As in all Windows-compliant applications, when you save an AutoCAD file for the first time by choosing Save, you can designate a name for the file and a folder in which to store it. I recommend that you create a special folder, called something like AutoCAD NER, for storing the files you’ll generate as you work your way through this book. This will keep them separate from project work already on your computer, and you’ll always know where to save or find a training drawing. To save your drawing, follow these steps:

[image: m0310.tif]

1. In AutoCAD, click the Save button on the Quick Access toolbar or choose Save from the Application menu. Because you haven’t named this file yet, the Save Drawing As dialog box opens, as shown in Figure 3-22.

The Save button in the Quick Access toolbar, the Application Menu Save option, and the Ctrl+S key combination actually invoke the QSAVE (Quick Save) command in AutoCAD.

QSAVE only asks for a filename when the drawing has not yet been saved for the first time, after which it simply overwrites the existing file without prompting. Entering the SAVE command at the command line (SAVE↵) always opens the Save Drawing As dialog where the filename and path are modified.


Figure 3-22: The Save Drawing As dialog box

[image: f0322.tif]
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NOTE The actual folders and files may be different on your computer.



2. In the Save In drop-down list, designate the drive and folder where you want to save the drawing. If you’re saving it on the hard drive or server, navigate to the folder in which you want to place the new AutoCAD NER folder.

[image: m0311.tif]
3. Click the Create New Folder button near the top-right corner of the dialog box. The folder appears in the list of folders and is highlighted. It’s called New Folder, and a cursor flashes just to the right of the highlighting rectangle.

4. Enter AutoCAD NER↵ (or whatever name you want to give the new folder).

5. Double-click the new folder to open it.

6. In the File Name box, change the name to 03A-FPLAYO. You’re not required to enter the .dwg extension.

7. Click Save. Notice that the AutoCAD title bar displays the new name of the file along with its path. It’s now safe to exit AutoCAD.

8. If you want to shut down AutoCAD at this time, choose Application Menu Exit AutoCAD or click the X button in the top-right corner of the AutoCAD window. Otherwise, keep your drawing up and read on.




U.S. National CAD Standard (NCS)

Where applicable, this book will employ the use of the U.S. National CAD Standard (NCS). Over the last several years, the popularity of this standard has grown immensely, and it is now in use by many of the top architectural and engineering firms. You’ll learn more about the NCS when we begin learning about layers, but for now we’ll stick to file naming. Per the NCS our cabin drawing is considered a model drawing, whose standard file-naming structure is as follows:


[image: g0301.eps]


The discipline portion of an NCS filename must be one of the predefined single-letter codes listed in Chapter 6, “Using Layers to Organize Your Drawing,” which explores the naming convention as applied to layer names. 

The U.S. National CAD Standards have proven flexible enough to support firms both large and small. By working through this book you’ll get a good introduction to how the NCS works. If after reading this book you would like to learn more about the National CAD Standards, visit http://nationalcadstandard.org.

From now on, when you’re directed to save the drawing, save it as ##A-FPLAYO, with ## indicating the two-digit number of the chapter (for example, 03 for Chapter 3). This way, you’ll know where in the book to look for review, if necessary. Name multiple saves within a chapter ##A-FPLAY1, ##A-FPLAY2, and so on. To save the current drawing under a different name, use the SAVE AS command (Application Menu  Save As or SAVEAS↵).




[image: tip.tif]
You can also access a full range of additional resources including tutorials, videos, and more specific to the exercises in this book from www.autocadner.com.



The tools covered in this chapter are your keys to starting a new drawing from scratch and getting it ready for a specific project.

A Summary of AutoCAD’s Units

The following is a brief description of each of the linear and angular unit types that AutoCAD offers and how they are used. The example distance is 2′-6½″. The example angle is 126°35′10″.

Linear Units

The linear unit types that AutoCAD uses are as follows:

Architectural This unit type uses feet and inches with fractions. You must use the foot sign (′): for example, 2′-6½″. For this distance, enter 2'6-1/2 or 2'6.5. For the most part, these are the units that you’ll use in this book.

Decimal This unit type uses Decimal units that can represent any linear unit of measurement. You don’t use the foot sign, the inch sign, or fractions. This method is especially common in the civil engineering discipline where Decimal units are used, and 1 unit is equal to 1 foot. Therefore, for the distance 2′6½″ you would need to convert the inches (6.5 inches in this case) to the decimal equivalent of a foot (6.5/12 = .5417). So in this case, you would enter 2.5417.

Let’s say you needed to draw a line 10′3″ long in a drawing where 1 unit was equal to 1 foot. You would need to convert the inches to the decimal equivalent of a foot. So in this case 3/12 = .25, and so you would enter 10.25.

Conversely, if each unit was equal to an inch, that same 2′ 6½″ line would be entered as 30.5(2  12) + 6 = 30 and 6/12 = .5.

Engineering This unit is equivalent to Architectural units except that inches are displayed as decimals rather than fractions. For a distance of 2′-6½″, enter 2′6.5 or 2.5417′. In either method, the resulting distance is displayed as 2′-6.5″.

Fractional These units are just like Architectural units except there is no use of feet. Everything is expressed in inches and fractions. If you enter 30-1/2 or 30.5, the resulting distance displays as 30½.

Scientific This unit system is similar to the Decimal unit system except for the way in which distances are displayed. If you enter 3.05E+01, that is what is displayed. The notation always uses an expression that indicates a number from 1 to 10 that is to be multiplied by a power of 10. In this case, the power is 1, so the notation means 3.05  10, or 30.5 in Decimal units.

Angular Units

The angular unit types that AutoCAD uses are as follows:

Decimal This type uses 360° in a circle in decimal form, with no minutes and no seconds. All angles are expressed as decimal degrees. For example, an angle of 126°35′10″ is entered as 126.586 or 126d35′10″ and displays as 126.5861. AutoCAD uses the letter d instead of the traditional degree symbol (°).

Deg/Min/Sec This is the traditional system for measuring angles. In AutoCAD’s notation, degrees are indicated by the lowercase d, the minutes use the traditional', and the seconds use the traditional". The use of this system is generally reserved to the civil engineering discipline, as most users now use decimal angles instead of this system and choose their preference for precision.

Grads This unit is based on a circle being divided into 400 grads, so 90° equals 100 grads. One degree equals 1.11 grads, and 1 grad equals 0.90 degrees. AutoCAD uses g as the symbol for grads.

Radians The radian is the angle from the center of a circle made by the radius of the circle being laid along the circumference of the circle.

One radian equals 57.3 degrees, and 360° equals 6.28 radians, or 2π radians. AutoCAD uses r as the symbol for radians.

Surveyor These units use bearings from the north and south directions toward the east or west direction and are expressed in degrees, minutes, and seconds. They’re discussed in Chapter 12. In this example, 126°35′10″ translates to N 36d35′10″ W in bearings, or Surveyor units.

The next chapter will focus on adding to the drawing, modifying the commands you learned as part of Chapter 2, and creating strategies for solving problems that occur in the development of a floor plan.

Are You Experienced??

Now you can…


	set up linear and angular units for a new drawing

	make the grid visible and modify its coverage

	use the Zoom In and Zoom Out commands

	activate the Snap mode and change the Snap and Grid spacings

	use the Zoom All function to fit the grid on the drawing area

	draw lines using the Grid, Snap, and Dynamic Input features

	create a new folder on your hard drive from within AutoCAD

	name and save your file








End of sample




    To search for additional titles please go to 

    
    http://search.overdrive.com.   
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